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Warranty / Lease / Support 

One Year Hardware Limited Warranty 

GL Communications Inc. warrants the hardware products against defects in material and workmanship 

for a period of one year from receipt of the product to the recipient. If GL receives notice of defects 

during the warranty period, GL will either replace or repair the product and its components. In the 
event that GL is unable to repair or replace the product (After receipt of the defective product from the 
customer) within a reasonable period, the customer shall be entitled to refund of the purchase price. 

One Year Software Limited Warranty 

GL Communications Inc. warrants the licensed software products to perform in substantial con-
formance to the applicable GL software specifications for a period of one year from receipt of the 
product to the recipient. If GL receives notice of defects during the warranty period, GL will either 
replace or repair the product and its components. In the event that GL is unable to repair or replace 
the product (After receipt of the defective product from the customer) within a reasonable period, the 

customer shall be entitled to refund of the purchase price. 

Extended 1 Year (total 2 years) Hardware Warranty (SA023) is also available. Please contact GL 
Communications Inc for purchasing extended hardware warranty. 

The basic 1-year hardware warranty is provided with the initial purchase price. The customer may 

renew this warranty service on a yearly basis and enjoy the benefits of first year service for the 
additional years. The basic and extended service includes the following:  

All hardware (excluding PC) is warranted for one year from the date of purchase. GL will assist the 
customer to troubleshoot the purchased equipment to determine if hardware or software is defective. If 
hardware is determined to be defective, customer is required to send the defective equipment at their 
cost. GL will pay for return shipping charges. Replacement equipment will be sent if necessary to 
reduce downtime to the customer. In most cases the product will be shipped back to the customer 
within a few days. However, the product may remain at GL for a reasonable period of time, while 
waiting for replacement/repaired parts. 

The above ‘Extended Warranty’ shall not apply to defects resulting from improper operation, 
inadequate maintenance, shipping damage, power surge, or unauthorized use or modification by the 
customer of the product. 

The following items are not covered by the extended warranty: 

Rack/Tower Computer Case; Rack/Tower Computer Fans; Rack/Tower Computer Keyboard; 

Rack/Tower Computer Mouse; Rack/Tower Computer Monitor; Rack/Tower Computer Video Card; 
Lunchbox Computer Case; Lunchbox Computer Screen; Lunchbox Computer Video Card; Lunchbox 

Computer Keyboard/Mouse; Laptop Computer (entirety); Any external peripherals added to the 
computer. 

Extended 1 Year (total 2 years) Software Warranty (SA022) is also available. Please contact GL 
Communications Inc for purchasing extended software warranty. 

The basic 1-year software upgrades and comprehensive support is provided with the initial purchase 
price. The customer may renew this warranty service on a yearly basis and enjoy the benefits of first 
year service for the additional years. The basic and extended service includes the following: 

 Telephone, e-mail, IM, and Skype based technical support during regular GL business hours with 
prompt and courteous problem resolution.  

 Assistance to the customer to troubleshoot the purchased equipment to determine if hardware or 
software is defective. If software is determined to be at fault, GL will expeditiously debug and 

repair the software at no cost to the customer. E-mail, FTP, and priority FedEx or equivalent will 
be used to send the repaired software to the customer.  

 GL will maintain problem record tracking of all customer issues.  

 Software upgrades, bug fixes, and patches shall be provided at no cost to the customer during the 

warranty period.  

Extended 1 Year (total 2 years) PC Warranty (SA027 for Lunchbox PC, SA028 for Briefcase PC) 
is also available. Please contact GL Communications Inc for purchasing extended PC warranty. 

The basic 1-year PC warranty is provided with the initial purchase price. The customer may renew this 
warranty service on a yearly basis and enjoy the benefits of first year service for the additional years. 
The basic and extended service includes the following: 

The PC is warranted for one year from the date of purchase. GL will assist the customer to troubleshoot 
the purchased equipment to determine if the PC hardware or software is defective. If hardware is 
determined to be defective, customer is required to send the defective equipment at their cost. GL will 
bear the return cost. Replacement equipment will be sent if necessary to reduce downtime to the 
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customer. If PC software is determined to be defective, GL may elect to send new software and repair 
the unit remotely. 

In most cases the product will be shipped back to the customer within a few days. However, the 
product may remain at GL for a reasonable period of time, while waiting for replacement/repaired 

parts. 

The above ‘Extended Warranty’ shall not apply to defects resulting from improper operation, problems 

arising from abuse, screen burn-in, inadequate maintenance, shipping damage, power surge, computer 
virus, or unauthorized use or modification by the customer of the product. 

Warranty Exclusions and Limitations 

The above warranty shall not apply to defects resulting from improper operation, inadequate 

maintenance, or unauthorized use or modification by the customer of the GL products or software. The 
warranty services and services beyond the warranty period described herein are the customer's sole 
remedies. In no event shall GL be liable for any direct or indirect or consequential damages. 

Obtaining Service During and Beyond Warranty Period 

To obtain warranty service, the customer shall return the GL product to GL Communications with proof 
of purchase and an explanation of the problem. The customer shall pay for shipping charges and GL 
shall pay for return shipping. For service beyond the warranty period, contact GL for details of available 

service. 

GL’s return policy:  

GL Communications Inc. accepts returns or exchanges within 30 days from the original purchase. All 

returns and exchanges must be in original condition and include all accessories. All returns, exchanges 
and price adjustments will be made in the country of original purchase. GL Communications Inc 
reserves the right to request identification and to deny any return. 

EC Declaration of Conformity for the EC EMC Directive (89/336/EEC) 

The GL Analysis cards comply with the requirements for a Class A device under the provisions of 
EN55022, Harmonized European Norm EN55022: 1994 known as Limits and Methods of Measurement 
of Radio Disturbance Characteristics of Information Technology Equipment.  

The GL Analysis cards comply with the requirements of EN50082-1: 1992 known as Electromagnetic 
Compatibility - Generic Immunity Standard Part 1. Residential, Commercial and Light Industry  

All measurements were performed at Washington Laboratories, Ltd., test center in Gaithersburg, MD, 

USA.  

Software Support/Upgrade 

Customer Support 

GL Communications provides quality support for all users of the GL software. If you require technical 
assistance or have problems getting started with the software, please contact our support team using 
the following: 

GL Communications Inc. 
818 West Diamond Avenue - Third Floor 

Gaithersburg, MD 20878 
Voice 301-670-4784 
Fax 301-670-9187 

Web page: http://www.gl.com/ 

E-mail: gl-info@gl.com 

Software Upgrade 

The GL software will be upgraded on a periodic timeframe (usually once every three months).  

However the interim software releases may also be available on a routine basis.  Please contact 
customer support for information concerning interim software releases. 

All software upgrades are available on the GL Communications web site (www.gl.com). Download the 

latest upgrade (available id devices are covered under warranty). If additional licenses are required, 
contact GL Communications (using voice or email). Please note that before upgrading the any GL 
software, the existing installation directory should be backed-up to another location. This will 
allow the user to revert to the previous software in case a problem arises during upgrading. 

GL Rental/Lease Plan 

GL equipment can be rented or leased. GL requires a two-month minimum. The monthly charge for 
Months 1 through 6 is 20% of the value of the equipment selected. The 7th and last month's payment 
is 10% of the value of the equipment. After the 7th payment, ownership transfers to the renter/lessee. 
75% of cumulative payments are applicable towards outright purchase at any stage. 

http://www.gl.com/
mailto:gl-info@gl.com
http://www.gl.com/
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Section 1.0 Introduction to GL Communications’ tScan16™ T1/E1 Analyzer 

1.1 Overview 

GL's tScan16™ extends the family of GL’s T1/E1 platforms with greater density, increased ports, and 

reduced power. tScan16™ is a high-density board with 16 T1/E1 ports and the newer PCIe (x1) bus 
interface. The sixteen T1/E1 ports are receive-only ports optimized for high performance voice and 
data capture, monitoring, and analysis  requirements.  

 

Figure 1: tScan16™ T1/E1 Board and Breakout Box 

 

The tScan16™ Breakout Box is used to receive the T1/E1 traffic on 16 ports for tScan16™ application. 
It consists of 8 pairs of Line and Equipment RJ45c ports. User need to connect straight cables to Line 
side and Cross-over cables to Equipment side to receive the signals from both Line and Equipments. 
Refer to the figure below to know the port numbers in the Breakout Box. 

 

 

Figure 2: MDR 36-pin Connector to tScan16™ Breakout Box- Pinout 
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Comparison and advantages of the new tScan16™ over Quad/Octal T1/E1 Boards is given in the 
following table 

 

Feature Quad, Octal T1/E1 Boards tScan16™ T1/E1 Boards 

Number of Ports 4, 8 (Tx and Rx) 16 (Rx only) 
31x16 = 496 timeslots for E1 

24x16 = 384 timeslots for T1 

Board Height: Standard PCIe board Standard PCIe board or 2U 

PC Bus: PCIe v1.1 x1 PCIe v1.1 x1 

Adapter Board: Quad: none; Octal: 4 port 

daughterboard 

16 port RJ45 Breakout Box with MDR 

36-Pin Connector (3M Mini D Ribbon 
cable) to interface with main board 

T1/E1 Connectors: RJ-45 RJ-45 with Inline Monitoring T1/E1 

T1/E1 Termination 

modes: 

Terminate, Bridge, Monitor Terminate and Monitor  

(on main board) 

T1/E1 interface 

modes: 

Normal Mode, Cross-port 

Through Mode 

Receive Only into main board. 

Breakout adaptor board connects 
equipment side and line side using 
RJ45 connector. 

 

1.2 Pre-Requisites 

 

 PC Requirements –Windows® 7 or 8 (32 bit or 64 bit).  

 CPU Requirements – Core i3 to i7 or equivalent, 4 GB Memory, USB 2.0 Port 

 Mother board with PCIe x1 slot. 

 

Within the package, you will find  

 tScan16™ PCIe Main Board 

 tScan16™ Breakout Box 

 MDR 36-Pin Connector (3M Mini D Ribbon cable) to interface Breakout Box with Main Board 

 Suporting Documentation – User’s Manual, Quick Install Guide, and Quick Start Guide.  
 

 

 

1.3 Installing Driver and Software 

Please refer to the Installation Guide for complete details. The analyzer software supports installation 

on 32-bit version and 64-bit version of Windows® 7/8 Operating Systems. For details refer to 
Installation User’s Guide for respective hardware platforms. 
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1.4 Invoking T1/E1 Analyzer 

The T1/E1 Analyzer software can be invoked in one of the following ways: 

 

Figure 3: tScan16™ T1/E1 Application Main Screen 

 

 Click the shortcut icon for the tScan16 T1/E1 Analyzer from the desktop. 

 Click Start > All Programs > GL Communications > tScan T1/E1 Analyzer. 

 Double-click on TscanT1/E1 executable file located in ‘\Program Files (x86)\GL Communications 

Inc\tScan T1 Analyzer’ 

 

Once the tScan16™ T1/E1 application is invoked, the main tScan16™ T1/E1 analyzer screen appears 
as shown in the figure above. Some of the important features of these products are summarized in the 

sections below.  
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1.5 File Menu  

This feature is used to load/save profiles and exit from the program. 

 Load Profile can be used to reload the saved files. 

 

Figure 4: File Menu 

 Close Profile can be used to close a loaded profile. 

 Save Profile can be used to save the changes to the loaded profile. 

 Export Profile can be used to save the selected profile externally to a directory anywhere as a 
file of type *.pfr. 

 Import File can be used to save any exported profiles to the analyzer. 

 Delete Profile can be used to delete the loaded file from the registry. 

 Profile Applications lists all the tScan16™ T1/E1 applications that are supported for 

loading/saving using profiles. 

 Print Setup can be used to print the profile using user-specified printer and print options. 

 Exit can be used to close the application. 

 

1.6 Config Menu 

Permits configuration of the T1/E1 parameters along with an optional bit inversion software. Refer 

to the section Detailed Description of Configuration Menu Functions. 

 T1/E1 Configuration can be used to configure various Tx/Rx parameters. 

 Encoding Option can be used to select appropriate codec for T1/E1 lines. 

  

 WCS Configuration – Use WCS Server to set tScan16™ in client-server mode. User can set the 

WCS Server to start with default values at analyzer start-up. 

For more information on these features, refer to the section Detailed Description of Configuration Menu 
Functions.   

 

Figure 5: Config Menu 
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1.7 View Menu 

 It hosts shortcut toolbars for various applications,  hardware registers and driver info for diagnostic 
purposes. For more information on these features, refer to the section Detailed Description of View 

Menu Functions.   

 

Figure 6: View Menu 

 Note: 

VF Options are not supported on tScan16™ Boards.  

 Tool Bars can be used to create shortcut icons to invoke Monitor, Intrusive Test, Special 

Applications and various Protocol Analyzers. 

 tScan16™ Setup Dialog Bar can be used to set framing format, input line interface, , and lower 
status bar. 

 

 Diagnostic Applications 

Registers are included with the application to be used internally for diagnostic purposes and for remote 

debugging. These help in controlling various settings on the board that affects the logic operations 
applied to the T1/E1 stream. 

For more information on registers refer to the section Diagnostic Applications. 
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1.8 Monitor Menu 

Permits detailed viewing of the T1/E1 signal being captured. It includes display of Byte Values, Binary 
Byte Values, Signaling Bits, Power Level, DC Offset, Frequency, Multi-frames and Real-time Multi-

frames, T1/E1 data in Real-time Bitmap, Specific timeslot data, ASCII Timeslot Data, Oscilloscope view 
of a timeslot, Power Spectral view of a timeslot, Audio Monitoring, and Active Voice Level. For more 
information refer to the section Detailed Description of Monitor Menu Functions. 

 

Figure 7: Monitor Menu 

 Byte Values can be used to display the data values for each time slot in HEX data format. 

 Binary Byte Values can be used to display the data values for each time slot in binary data 
format. 

 Signaling Bits can be used for real-time display of all timeslots simultaneously. 

 Power Level (in dbm) can be used for real-time display of all timeslots simultaneously. 

 DC Offset can be used to display values for all timeslots. 

 Frequency can be used to display value for all timeslots. 

 Multi-frames can be used to identify the data in each frame. 

 Real-time Multi-frames can be used to refresh the data for about every second. 

 T1/E1 Data as Real-time Bitmap can be used as a graphical view of multi-frames and is 

rendered as a pixel map with zeros represented by white dots and ones represented by black dots. 

 Timeslot Window can be used to View the timeslot values on a desired timeslot for one-second 
duration. The user can also change the particular timeslot according to the need. 

 ASCII Timeslot Display can be used to view real-time ASCII events that are present on the T1 

or E1. The ability to display the ASCII events for a particular port and timeslot is provided. 

 Oscilloscope and Power Spectral displays can be used to provide the display of received data. 

 Active Voice Level can be used to obtain and analyze the source signal in real time from T1/E1 
timeslots, and processes signal data captured to files as an offline process. 
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1.9 Intrusive Test Menu  

The Intrusive menu option hosts Bit Error Rate Test as a line test application. For more information 

refer to the section Description of Intrusive Test Menu Functions. 

 

Figure 8: Intrusive Menu 

 Basic Bit Error Rate Test utility can be used to Test Full/Fractional/Framed/Unframed bits with 
Drop and Insert. 

 

1.10 Other Applications included with Basic Analyzer Software 

 Windows Client Server 

WCS (Windows Client Server), an application that uses remote C++ client/server mechanism for 

scripted mode execution option of T1/E1 operations. Refer to GL Client Server User’s Manual and 
GL Server Command Reference for more details. 

WCS (C++ Clients) Protocol Decode modules  – File based Record/Playback, Transmit/Detect 
digits, Multi-Channel HDLC Analysis & File based High Throughput HDLC Record/Playback, File based 
HDLC Record/Playback & Remote Record/Playback, Refer to T1E1 Client Server Console Based 

PDAM User’s Manual for more details. 

 

1.11 Special Applications Menu  

 

Figure 9: Special Applications Menu for T1 and E1 

A host of receive functionalities are provided under this menu, viz. Refer to 

http://www.gl.com/t1e1applications.html to visit the webpages and download the documentation, and 
brochures related to the applications of interest. 

 Protocol Analysis 

 Signaling Transitions displays real-time Signaling Bits Transitions of a timeslot data with 

timestamps. Refer to T1E1 Signaling Transition User’s Manual for more details. 

 Protocol Identifier analyses the frames flowing through each link over the T1/E1 lines and 

classifies the protocol/traffic based on analysis. Refer to T1E1 Protocol Identifier User’s 
Manual for more details. 

 HDLC Protocol Analysis capture and analyze HDLC frames. Refer to HDLC Analysis 
Emulation User’s Manual for more details. 

 ISDN Analysis is used to save high-level data link (HDLC) frames on T1/E1 real-time and 

offline channels. Refer to ISDN Analyzer User’s Manual for more details. 

 SS7 Analysis used to analyze SS7 signaling information over different interfaces. Refer to 

SS7 Analyzer User’s Manual for more details. 

http://www.gl.com/t1e1applications.html


Introduction to GL Communications’ tScan16™ T1/E1 Analyzer 

GL Communications Inc. 8 August 2014 

Document Number: T1E1-8.7.28-03 

 GSM Analysis is used to analyze GSM protocols, a switching and signaling 
telecommunication protocol between MSC & BSC, BSC & BTS, MSC & HLR, MSC & VLR, and so 
on. Also supports proprietary ‘Mobis’ Interface (Motorola equivalent of the GSM A-bis 
interface – requires additional license XX151) between BSC (Base Site Controller) – BTS 

(Base Transceiver Station) and BSC (Base Site Controller) – PCU (Packet Controller Unit). 
Refer to GSM Analyzer User’s Manual for more details. 

 GPRS (General Packet Radio Service) Gb and GPRS IP Gx Analysis are used for 
continuous data connectivity over wireless GSM networks with Gb, Gn, and Ga interfaces. 

Refer to GPRS Analyzer User’s Manual for more details. 

 UMTS Analysis is used to decode various UMTS protocols like NBAP, ALCAP, FP and more. 
Currently it has the capability to decode all protocols related to Iub interface of the UMTS 
network. Refer to UMTS Analyzer User’s Manual for more details. 

 GR303 Analysis used to analyze Gr303 message over T1/E1 interface. Refer to Gr303 

Analyzer User’s Manual for more details. 

 V5.x Analysis is used to save files with high-level data link (HDLC) Frames between Access 

Network (AN) and Local Exchange (LE) and operates only on E1 channels real time and off-
line. Refer to V5 Analyzer User’s Manual for more details. 

 FDL Decode and Analysis (T1 Only) uses saved files with high level data link (HDLC) 

frames and bit-patterned extended super frame (ESF) data link messages for both real-time 

and offline. The Playback File allows the user to transmit data directly into the FDL bit stream. 
The user may transmit raw data or valid HDLC frames (properly formed HDLC frame file 
required). FDL View and Save data allows the user to view the raw hex bytes received from 
the FDL bit stream, the Framing bit stream, or the CRC bit stream (in real time). Refer to FDL 
Analysis Playback User’s Manual for more details. 

 CAS Analysis supports monitoring and decoding of CAS signaling events over T1/E1 

networks. Supported CAS signaling types include MFC-R2 and R1. The real-time analysis is 
used to capture data on one or multiple T1/E1 lines on the specified timeslots simultaneously 
during transmission. Users can record all or filtered traffic into a trace file. The recorded trace 
file can then be analyzed offline and exported to ASCII file, or printed. Refer to CAS Analysis 
User’s Manual for more details. 

 Frame Relay Analysis is used to save high-level data link (HDLC) Frames on T1/E1 real-

time and offline channels. Refer to Frame Relay Analyzer User’s Manual for more details. 

 ATM Analysis is used to analyze ATM protocols across the U-plane for both NNI and UNI 

interface. Refer to ATM Analyzer User’s Manual for more details. 

 MLPPP Analysis with PDA provides useful analysis of the PPP, MLPPP, and MC-MLPPP 
protocols, which includes distribution of protocols, protocol fields, frame lengths and frame 
status. It supports Link Control Protocol, Password Authentication, Challenge Handshake 

Authentication, Bridging PDU, 802.1d Hello Packets and other IP based protocols like ICMP, 
STUN, DNS, DHCP, HTTP, FTP and SNMP. MLPPP analyzer also supports Packet Data Analysis 
module to perform detail analysis of MLPPP packets over IP and segregates them into SIP / 
H323 / Megaco / MGCP calls. Refer to MLPPP Analyzer User’s Manual for more details. 

 TRAU Analysis is used to analyze the TRAU frames and operates on E1/T1 real time and off-

line channels using saved files with frames. Refer to TRAU Analysis Emulation User’s 
Manual for more details. 

 TRAU ToolBox™ is used to create, monitor, and terminate TRAU GSM traffic calls (termed as 
TRAU sessions in this document). Once the TRAU session is created, different kinds of 

audio/voice/digits can be generated and analyzed on GSM call for voice quality analysis.  

 SS1 Analysis detects and analyzes tone sequences that make up SS1 dial digits. Sequences 
of pulse and guard tones are detected, decoded, and assembled into their corresponding dial 
digits.  The tone sequences are also verified. Refer to SS1 Signaling Analysis and 
Emulation User’s Manual for more details. 

 

 Windows Client Server Modules 

 WCS Dynamic DSP Operations – Scripted DSP commands provide the ability to specify a 

sequence of digital signal processing steps to be performed on incoming and/or outgoing 
timeslots. The application allows real-time as well as offline testing using DSP commands to 
perform functions such as Amplification/Attenuation, Delay, Filter, File Tx/Rx, Logical 
operations, Echo Cancel, and so on. Refer to GL Server Guide to DSP Operations and 
T1E1 Client Server DynDspOp Quick Guide for more details. 
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For details on other WCS Modules – refer to section WCS Modules 
(http://www.gl.com/client_server.html ) 

 Playback & Record Applications – Refer to section Playback and Record Applications and T1E1 

Client Server File Record Playback Command Reference for more details 

 File transmission/capturing from T1/E1 timeslots (single timeslots or all timeslots) using 

Playback File and Record Data to File applications. 

 Record from Multiple Cards option to record data (on all time slots) on the devices that are 
installed on the PC simultaneously. 

 Automated Record Playback is used to run several transmit or receive operation tasks 
simultaneously. 

 Automated Continuous Capture is used to capture seamless chunks of data in files of the 

same size. 

 Digit Detection and Transmission using Capture Dialed Digits and Transmit Dialing Digits 
applications. Refer to section Capture Dialed Digits & Tones and T1E1 Client Server TxRxDigits 
Command Reference for more details. 

 

 Call Capture and Analysis Applications 

 Call Capture and Analysis is used to record calls directly from T1/E1 lines and View PCM is 
used to view the captured files using ‘Cool Edit / Adobe audition / Goldwave/ Audacity’ upon 
installation. Refer to T1E1 Call Capture and Analysis User’s Manual for more details. 

 Call Data Records (CDR optional application licensed with dongle) application is used to 

provide an overall summary of the call as well as the event-by-event account of each call. 
Refer to T1E1 Call Data Records User’s Manual for more details. 

 Voice band Analyzer (VBA – optional application licensed with dongle) is an analysis tool for 

monitoring voice band network traffic. The VBA can host different analysis modules for 
monitoring speech and noise levels, and line echo. Refer to Near Realtime VBA for more 
details. 

 Fax decoder/demodulator (FaxDD™) module (licensed as VBA038) within VBA can be used 

to decode both 2-wire and 4-wire voice band captures to produce the Fax TIF image and 
other transmission information. Fax decoder/demodulator is also available as stand-alone 
command line application. 

 Multiple Call Capture (beta) application is used to monitor hundreds of calls, capture the 
bidirectional data, signaling and traffic, simultaneously from multiple T1/E1 lines, based on 

the user-defined trigger configurations. Refer to T1E1 Multi Call Capture and Analysis 
User’s Manual for more details. 

 

 Echo Test Solutions include Measure Loop Delay/ERL, Delay Attenuate Timeslots, and Digital 

Echo Canceller applications to generate echo and measure loop delay/echo return loss (ERL) on 
one or more time slots. DEC (Digital Echo Canceller) can be used for double-talk and tone 
detection. In addition to these applications, a waveform viewer application, GLC View, has been 
introduced to view previously captured raw data files and their corresponding windowed power. 
Refer to T1E1 Echo Test Solutions User’s Manual for more details. 

 Real-time Strip Chart option to capture and analyze signaling as well as PCM data captured at a 
specified timeslot. Refer to T1E1 Realtime Strip Chart User’s Manual for more details. 

 Real-time Multichannel Audio Bridge - On popular demand, audio streaming between T1/E1 

timeslots and a sound card is now available with the latest HD cards, USB and Universal 
Analyzers. The powerful feature of this audio driver is that the sound-card aware applications such 
as Goldwave, Matlab, and so on can send and receive data to/from a T1/E1 timeslot. Refer to 
T1E1 Realtime MC Audio Bridge User’s Manual for more details. 

file:///C:/Documents%20and%20Settings/Shilpa%20Giridhar/Application%20Data/Microsoft/Word/WCS%20Modules%20(http:/www.gl.com/client_server.html%20)
file:///C:/Documents%20and%20Settings/Shilpa%20Giridhar/Application%20Data/Microsoft/Word/WCS%20Modules%20(http:/www.gl.com/client_server.html%20)
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 DCME Analyzer (E1 Only) The latest specification for Digital Circuit Multiplication Equipment 
(DCME) is IESS-50 (Rev.3), which embodies a complex set of functions including variable rate 
encoding for voice (32, 24, and 16 Kbps ADPCM), Digital Speech Interpolation (DSI), and voice-
band data encoding at 40 Kbps ADPCM. Facsimile demodulation and remodulation is also included. 

By mid-1994, several vendors started to introduce DCME equipment built to these new 
specifications. Refer to DCME Analyzer User’s Manual for more details. 

 Voice Quality Assessment tool for clear, uninterrupted voice for all types of networks carrying 
voice traffic. Typical network applications include VoIP systems, PSTN, ATM networks, Frame 

Relay, and Wireless Networks.  

1.12 Windows Menu 

This menu permits management of monitor menu windows (when available) in cascade or tile form. 

 

Figure 10: Windows Menu 

1.13 Help Menu 

This menu provides the online help along with list of all the licensed optional applications. 

 
 

1.14 Optional Applications 

 

Figure 11: Optional Applications List 

The Optional Applications window displays all the other applications that are bought in addition to 
basic software. 
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1.15 About Analyzer 

The About Analyzer menu provides version numbers of the Software, Dynamic Link Library and 
Driver along with card numbers and other statistics for diagnostic use. 

 

Figure 12: About Analyzer 



Introduction to GL Communications’ tScan16™ T1/E1 Analyzer 

GL Communications Inc. 12 August 2014 

Document Number: T1E1-8.7.28-03 

(Intentional Blank Page) 



Hardware Interfaces & Specifications 

GL Communications Inc. 13 August 2014 

Document Number: T1E1-8.7.28-03 

Section 2.0 Hardware Interfaces & Specifications  

2.1 tScan16™ High-Density T1/E1 Board 

2.1.1 System Requirements 

Following are the computer requirements for a computer equipped with the tScan16™ T1/E1 Analyzer 
software. 

 PC with Windows®  7 (32-bit & 64-bit) / 8 (32-bit & 64-bit) 

 Processor Minimum Requirements - Dual Core processor, or Higher; Recommended - Quad Core 
processor 

 RAM Minimum Requirements - 1 GB RAM; Recommended - 4 GB RAM 

 PCIe x1 Slot 

2.1.2 Product Specifications 

Physical Interface 

T1/E1 Dual RJ45c Jacks on the Breakout Box 

Connector MDR 36-Pin Connector (3M Mini D Ribbon cable) to interface Breakout Box 

with Main Board 

PC Interface PCI Express X1 Lane 
Compliant to PCI Express Base Specification v1.1 

 
Environmental Specifications 

Temperature Operating: 0 to 50° C 
Storage: -50 to 70° C 

Relative Humidity Operating: 10% to 90% (non-condensing) 

Storage: 0% to 95% (non-condensing) 

Altitude Operating: -100 to 12,000 ft. 
Storage: -100 to 40,000 ft. 

 

T1/E1 Line Interface 

Framing Formats   Unframed, D4 (T1) , ESF(T1), ESF(J1), CAS(E1), FAS(E1), CRC4 

 Hardware Compliant: SLC96, T1ESF ZBTSI   

Line Code format AMI, B8ZS (T1) or HDB3 (E1) 

Altitude Operating: −100 to 12,000 ft. 

Storage: −100 to 40,000 ft. 

Internal Clock Specification Standard: +/- 3ppm Optional: +/- 1ppm 

 
PCM Interface 

Receive 

Displays for All Channels: Signaling Bits, Power Level, Frequency, & Data. 
Graphical displays: Oscilloscope, Spectral, Spectrogram, Signal-to-Noise 

Signaling: DTMF/MF Dialed Digit Detection and Analysis, ISDN, MFC-R2  
Recorder: Record Full/Fractional T1/E1 Timeslots to hard disk file. 
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Specification Compliance 

T1/E1 Interface Hardware 

Compliance 

ANSI: T1.403.1995, T1.231-1993, T1.408 

AT&T: TR54016, TR62411 

ITU: G.703, G.704, G.706, G.736, G.775, G.823, G.932, I.431, O.151, 

Q.161 

ITU-T: Recommendation I.432-03/93 B-ISDN User-Network Interface-

Physical Layer Spec 

ETSI: ETS 300 011, ETS 300 166, ETS 300 233, CTR12, CRT4 

Japanese: JTG.703, JTI.431 

Facility Data Link T1 ESF Mode: Transmit/Receive Messages, Bit-Oriented Messages, and 
Files. 

Zero Suppression B7 Stuffing, Transparent, & B8ZS (T1) 

Signaling  Robbed-Bit or Clear Channel 

Receive 

Input Impedance 100 ohms for Terminate and Monitor (T1) 

120 ohms for Terminate and Monitor (E1) 

Terminations Terminate and Monitor 

T1 Input Frequency 1.544MHz +/- 20KHz  

E1 Input Frequency 2.048Mhz +/- 20KHz  

Frequency Measurement +/- 1ppm 

Error Detection Frame Error, CRC Error,  

CAS Multiframe Error,  

BPV Error,  

Frame Alignment Error,  

10 or 24 bits for sync time,  

2/4, 2/5, or 2/6 frame bit in error frame select, Frame error bit corruption 
for 1 or 3 frame bits   

Alarm Detection T1 - D4 Yellow Alarm, ESF Yellow Alarm,  

Yellow Alarm (B2 Suppressed-2nd MSB),  

Yellow Alarm (S-Bit),  

Yellow Alarm (00FF in FDL), 

Blue Alarm (Framed or Unframed All Ones),  

E1 - Remote Alarm,  

Distant Multiframe Alarm, 

Signaling All Ones, 

Unframed All Ones, 

Hardware Compliant: J1 Yellow Alarm 

Input Range T1: Terminate: 0 to 36dB (Long Haul),  

0 to 15dB (Limited Long Haul),  

DSX Monitor: 20dB 

 

E1: Terminate, 0 to 43dB (Long Haul),  

0 to 13dB (Short Haul),  

DSX Monitor: 20dB 
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Display and Logging 

BERT 

Bit Errors, Bit Error Rate, Error Seconds, Error Free Seconds, %EFS, 
Severely Error Seconds, % SES, Degraded Minutes, %Dmin, Loss Pattern 

Sync Count, Loss of Sync Seconds, Available Seconds, %Available Seconds, 
Unavailable Seconds, Bipolar Violations, BPV Rate, BPV Seconds, BPV Free 
Seconds, Frame Errors, FE Rate, FE Seconds, FE Free Seconds, with Detailed 
logging into disk file. 

Alarms 

Resync In Progress, Loss of Signal, Blue Alarm,  
Change of Frame Alignment,  

Bipolar Violation, Frame Error,  
Carrier Loss, Yellow Alarm,  
Out of Frame Events Counter,  
Error Super frame Counter, Bipolar Violations,  
Remote Alarm, Distant Multiframe Alarm,  
Signaling All Ones, CAS Multiframe Error, CRC4 Error. 

 
Computer Requirement 

Core i3 or higher with MS-Windows® 7 or 8 with PCIe expansion slots (3.3V or 5.0V) 
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Section 3.0 Detailed Description of File Menu Functions 

This menu provides various options to load, save, delete or print profile in addition to closing the T1/E1 
application. 

3.1 Profiles features and options 

The Profile feature under File Menu provides the ability to load and save preset configurations. 

Profile feature can be used to save (store in registry) several user-defined application windows for 
repeated use, such as a given combination of T1/E1 application windows, sizes, positions, etc. 
Whenever the user desires the same configuration of T1/E1 applications or wants to simulate the same 
scenario, the user can open the saved profile and start working with it. Additionally, users can ‘import’, 
‘export’, or ‘delete’ a profile.  

 

Figure 13: File Menu Options 

Different options available for the profile feature are: loading saved profiles, saving new profiles, 
importing profiles, exporting profiles, and deleting profiles. 

The profiles are saved with the file name extensions *.pfr. They are stored in the registry. The loaded 

profile will be shown in the status bar of the GUI window. Supported applications for profile 
loading/saving are listed as shown in the Supported Applications for Profiles Loading / Saving.  

 

3.2 Creating and Saving Profile 

A profile can be created after opening the desired application windows, and setting various parameters 
such as timeslots for applications, card number, loop-backs, framing format, interface options, window 
sizes, etc. To create a profile, select Save Profile As from the File menu and provide a file name. 

 

3.3 Load Profile 

Saved profiles can be reloaded. The settings of the applications can also be saved and loaded for 
another instance using T1/E1 analyzer’s Save-Load Profile option. 

Click Load Profile from the ‘File’ menu. Select a file from the Load Profile window. 

 

Figure 14: Load Profile 
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Load Profile feature is also supported in the command line using the appropriate command for T1 or E1 
analyzer command as shown in the figure below. Ensure that the profile should be present in the 
specified path to load a profile; else an error message would be generated in the CLI window.  

 

Figure 15: Load Profile Feature 

In the above commands, P1 is the user-defined profile name. 

 

 Note: 

Only one profile can be loaded at a time. The loaded profile will be shown in the status bar of the GUI window. 

 

3.4 Close Profile 

Select Close Profile from the File menu. Closing a profile will clear the previously loaded profile as 
well as the profile name from the status bar of the GUI window. 

 

3.5 Save Profile 

This feature appears active under the File menu, only when a profile is already loaded and is in use. 
Changes can be made to an opened profile such as addition/deletion of windows, changing card#, 
timeslots for existing windows. The user must make the changes and click Save Profile from the File 
menu. All the changes will be recorded under the opened profile name. 

 

3.6 Delete Profile 

Select Delete Profile from the File menu to remove the profile from the registry. 
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3.7 Export and Import Profile 

Export Profile feature allows the user to save the selected profile externally in a directory as a file of 
type *.pfr. Import Profile feature allows any externally saved exported profiles (of type *.pfr) to be 

imported to the analyzer.  

 

Figure 16: Import Profile 

 

Figure 17: Export Profile 

 

3.8 Profiles-Supported Applications 

This window lists all the applications that supports profile feature saving as shown in the figure.  

Following are the complete list of supported T1/E1 applications that can be saved or loaded using 
profiles: 

 

Figure 18: Supported Application for Profiles Loading / Saving 
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3.8.1  Monitor Menu 

 Byte Values 

 Binary byte values 

 Power Level 

 DC Offset 

 Frequency 

 Multiframes 

 Real-time Multiframes 

 Time Slot Window 

 Oscilloscope 

 Power Spectral 

 Audio Monitoring 

 

3.8.2 Intrusive Test Menu 

 Basic Bit Error Rate Test 

 

3.8.3 Special applications 

 Signaling Bits 

 Playback File 

 Record Data to File 

 Automated Continuous Capture 

 Windows Client Server 

 Multiple Call Capture 

 

3.9 Compatibility 

Within an operating system (Win 7 /Win 8 – 32-bit and 64-bit versions) 

 Analyzers in the same or different machines can import profiles exported by other analyzers.  

Limitations of profile feature 

 Only one profile can be loaded at a time. 

 Profiles are compatible with the OS they were created under only.  

 Profiles created for 4 interfaces cannot be imported accurately by 2 single interfaces.  
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Section 4.0 Detailed Description of Configuration Menu Functions 

4.1 Encoding Option 

 

Figure 19: tScan16™ T1/E1 Analyzer Encoding Option 

Generally, T1 systems use Mu-law codec, and E1 systems use A-law codec for voice band signal 
encoding and decoding. The Encoding Option in tScan16™ T1/E1 Analyzer software permits encoding 
and decoding using any one of the above formats. 
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4.2 Configuration Setup for T1/E1 

Various options have been provided to configure the Rx parameters for tScan16™ T1/E1 Cards. A 
detailed description of configuration setup for T1 and E1 products is explained in the sections below. 

 

4.3 E1 Products 

4.3.1 Rx Tab 

 

Figure 20: Rx Tab in tScan16™ E1  

CAS Multiframe Sync Criteria 

This option is declared when the multiframe alignment pattern is properly detected and timeslot 16 of 

the previous frame contains a code other than zeros. If no valid pattern can be found in 12 to 14 
milliseconds, frame search is restarted. This procedure can be modified to include reception of two 
additional valid multiframe alignment patterns. 

There are two options: 

 Fixed Sync Criteria 

 Fixed + 2 Valid Multiframe Alignment Signals 

 

 

CAS Multiframe Resync Criteria 

 In E1, the receiver will automatically initiate frame search whenever two consecutive CAS 
multiframe alignment words are received in error. This can be modified to also initiate a frame 
search if two consecutive timeslot 16 words contain four zeros in the most significant positions 
(0000XXXX).  

There are two options: 

 Fixed Resync Criteria. 

 Fixed and/or 0000XXXX in two Consecutive Timeslot 16. 
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Receive Equalizer Gain  

This Permits the receiver to adjust to receive signal level and you can select the option accordingly as 

shown in the above figure. 

Frame Resync criteria 

 In E1, the receiver will automatically initiate frame search whenever the alignment word is 
received an error for three consecutive times. This can be modified to also initiate a frame search 
if three consecutive bit 2 errors occur in timeslot 0 of non-align frames. 

There are two options below this 

 Fixed Resync Criteria 

 Fixed and/or Bit 2 Timeslot 0 of non-align frames in error on three consecutive occasions. 

 The frame sync criteria for the receiver are valid reception of the frame alignment word in frame N 
and in Frame N+2 and bit 2 of frame N+1 is also a ‘1’. Multiframe sync search is initiated when 
frame sync is received.  

Auto Resync and Forced Resync 

In E1, when this option is enabled, the receiver will automatically resync to the received bit stream 

whenever synchronization is lost. Disabling auto resync will cause the receiver to maintain the current 

framing position despite the loss of sync. Activating forced resync causes the receiver to resync 
immediately. 
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4.3.2 Tx & Rx Tab 

Signaling Onhook/Offhook 

This is defined by configuring the ABCD signaling bits. Other modules in the Analyzer application use 

these settings. 

Receive and Transmit Data Formats 

Two line coding formats are provided: Alternate Mark Inversion (AMI) and High Density Bipolar with 3 

Zero Substitution (HDB3). HDB3 is checked as the default option and ensures that any length of zeros 
can be transmitted without synchronization problems. 

 

Figure 21: Tx & Rx Tab in tScan™ E1  
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Transmit Align Frame Position 

The CEPT frame structure consists of a frame of length 256 bits divided into 32 timeslots. The first 

timeslot commonly referred to as timeslot 0, contains a frame synchronization word in every other 
frame. Frames that contain the synchronization word are referred to as align frames and ones that do 

not contain the synchronization are referred to as non-align frames. Multi-frames can either begin with 
an align frame or a non-align frame. The E1 card provides for both options. 

 Note: 

This option has been disabled for USB T1/E1 and t Probe™Analyzer. 

Transmit Remote Alarm 

When this option is enabled, a remote alarm indication is sent and a fault condition affecting the entire 

receive PCM multiplex is detected. A remote alarm is signaled to the remote PCM multiplex via bit 3 of 
timeslot 0 of non-align frames. A bit 3 value of ‘0’ indicates no alarm condition and a ‘1’ indicates an 
alarm condition. The E1 card allows the ability to enable or disable this alarm condition on the outgoing 
bit stream. 

TX Distant Multiframe Alarm 

Loss of multiframe alignment is signaled to the remote PCM multiplex via bit 6 of timeslot 16 in frame 

0. Bit 6 of 0 indicates no alarm condition and 1 indicates an alarm condition. The E1 Cards allow the 
ability to enable and disable this alarm condition on the outgoing bit stream. 

Jitter Attenuation and Jitter Attenuation Bandwidth 

This menu has three selections, which enable or disable the jitter attenuation block of the line interface 

unit. Selection of the Jitter attenuation in the receive path will allow the receiver to accept more jitter 
at the receiver input as per the receiver tolerance specifications. Selection of the jitter attenuation in 
the transmit path will place the jitter attenuator in the transmit path to reduce the transmit jitter. The 
disabled selection will remove the jitter attenuator from the ‘transmit and receive’ sides of the line 
interface. 

4.3.3 Device Selection 

When you click on the Device Selection Tab the setup for DpciHdE1 dialog box opens as shown in the 
figure below. Here you have the option to select the cards from Card#1 to Card #16 to receive signals 

(for onhook/offhook). 

 

Figure 22: Device Selection Tab 
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4.4 T1 Products 

4.4.1 Rx Tab 

 

Figure 23: Rx Tab in tProbe™ T1 

Auto Resync 

This option allows you to completely disable automatic resync, apply resync on an OOF (out of frame) 
condition and /or on receive carrier loss (RCL) condition. 

Resync Algorithm 

This option allows you to declare how many bits must be qualified in the framing pattern before the 

receiver declares the synchronization. One option specifies that 10   consecutive Ft or FPS framing bits 
must be qualified. Another requires 24 consecutive Ft or FPS framing bits before declaring 
synchronization. 

 

Ft and Fs 

The odd F-bits, designated as Ft (terminal framing) bits always carry a repeating pattern of ‘101010’. 
The even F-bits, designated as Fs (signaling framing) bits carry a different sequence (001110), which 

identifies multiframe boundaries. 

 

Resync Using 

This option allows you to modify the algorithm employed to search for and qualify the framing 
alignment. There are two different qualifying conditions available for each framing mode (193S or 
193E). 

 When operating with the 193S-framing format, either ‘Ft’ or ‘Ft and Fs’ bits can be used during 
resync. When using Ft and Fs bits, the Ft and Fs patterns are crosschecked to find sync, and both 
patterns must be valid before sync is declared. When using only Ft, the only bits checked for 
framing are the Ft bits. 

 When operating with the 193 E Framing format, either ‘FPS’ or ‘FPS and CRC’ bits can be used 

during resync. When using FPS and CRC bits, the FPS and CRC bits are cross-checked to find sync, 
and both patterns must be valid before resync is declared. When using only FPS, the only bits 
checked for framing are the FPS bits 
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Out-of-Frame Criteria 

This option specifies how many framing bits (Ft or FPS bits only) must be in error before the receiver 

declares an out of frame condition. The possible selections are 2 out 4 framing bits in error or 2 out of 
5 framing bits in error. 

Network Loop-back Detection 

If this option is enabled it detects the CSU (channel service unit) Loop Up and CSU Loop Down Codes. 

 

Receive Equalizer Gain 

This option permits the receiver to adjust to the receive signal level, by selecting the radio button as 

shown in the figure above. 

 

Forced Resync 

This feature is used to force a receiver resync. 

4.4.2 Tx Tab 

   

Figure 24: Tx Tab in tScan™ T1 

Transmitting Yellow Alarm 

If this is enabled, a yellow alarm in the format specified in the TxRx Tab is transmitted and maintained. 

For more details on Transmitting Yellow Alarm and Idle Code Selection refer to the section Tx Tab 

Transmitting Blue Alarm 

A Blue Alarm, either an unframed sequence of all ‘1's, or framed sequence of all ‘1's’ can be 

transmitted. You can disable this option by clicking the Disable radio button. A Blue Alarm, also called 
an Alarm Indication Signal, or AIS, overrides all the other transmit data. 

 

Figure 25: Blue, Yellow and Red Alarms  

Line Length Select 
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In T1, the transmit section of the line interface chip can pre-equalize for line lengths from 0 to 655 feet 
(as measured from the transmitter to the DSX-1 cross connect). The length can be selected in five 
ranges (as shown in the figure above) and they meet pulse shape requirements of CB-119 when using 
ABAM cable. The pulse shapes also meet CCITT pulse shape requirements for 1.544 MHZ operations. 

Idle code selection 

Idle code selection is 7f for mulaw used on T1. However you can set idle code to 7e, ff or even to any 

other hex value as the option is provided there. 

4.4.3 Tx_Rx Tab 

Zero suppression 

In T1 systems, the data may be encoded in a bipolar AMI (Alternate Mark Inversion) format. If so, 
successive ‘1's’ are encoded alternately as positive and negative pulses. A zero is encoded as zero volts 

i.e. no pulse. Therefore, a long string of ‘0's’ is indistinguishable from a dead line. Since clock recovery 
circuits at T1 receivers maintain clock synchronization by synchronizing to the ‘1’ pulses in the 
transmission stream, synchronization can be lost if there are too many consecutive zero's. To prevent 
this, ‘1's’ density of at least 12.5% of the bits is required.  An additional requirement is that there 
should be no more than 15 consecutive ‘0's’ in the bit streams.  

In addition to Transparent Mode, following two zero-substitution schemes are available: 

 B7 zero substitution 

 B8ZS zero substitution 

 

Transparent Mode 

For voice grade applications, robbed-bit signaling does not noticeably degrade the signal quality. For 
data applications, selecting transparent mode can disable robbed-bit signaling. They have been 
developed to meet these requirements. More explanation on Robbed-Bit signaling and Transparent 

Mode can be found at 193S (D4) Framing Format. 

 

Figure 26: Tx Rx Tab in tScan™ T1  

B7 zero substitution 

This is used by A/D converters in channel banks, Bit 7 (2nd LSB) of an all zero codeword is replaced by 

a ‘1’. This guarantees at least one ‘1’ in all channels at the expense of some distortion in large 
amplitude signals.  
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 Note: 

Since in channel banks, all code words are inverted before transmission, the all zero codeword represents the 
highest signal amplitude. 

 

This method of zero suppression satisfies AT&T's 12.5% ones density requirement, and guarantees that 
more than 15 consecutive zeros will never occur.  A drawback of this format is that it's impossible for 

the receiving end to detect and remove the changed bit. This makes B7 zero suppression unacceptable 
for data transmission where integrity of the data must be maintained. 

B8ZS zero substitution  

This overcomes the inability of AMI line coding to support long strings of zeros, B8ZS (Bipolar Eight 
Zero Substitution) line coding is being selectively introduced into the network.  B8ZS allows 
transmission of long strings of zeros without modifying the data.  When B8ZS is enabled at the 
transmitter any eight consecutive zeros in the transmit bit stream (even across timeslot boundaries) 
are replaced with an 8 bit code that violates the AMI rule in a specific manner.  At the receiver these 
violations are automatically detected and replaced with eight zeros before any other processing is done 

on the incoming data.  On the receive side B8ZS is always Enabled and decoding of a B8ZS codeword 
is performed automatically. 

 

Figure 27: B8ZS  

Yellow Alarm Formats 

A transmitter sends this type of format whenever a loss of synchronization exists at the receiver for 

more than 2 to 3 seconds. The yellow alarm is an indication to the remote transmitter of this condition. 
Several different techniques are used for transmitting a yellow alarm depending on the framing format.  

 193S Yellow alarm format supports two different yellow alarm formats. The format selected is 
used by both transmit and the receive sides. When B2 Suppressed is selected, the format for the 
yellow alarm is a ‘0’ in bit 2 (2nd MSB) of all channels.  When 12th Frame S-Bit is selected, the 
format for a yellow alarm is a ‘1’ in the S-bit position of frame 12. Either setting is only effective 
when using 193S framing. 

 193E Yellow alarm format supports two different yellow alarm formats, B2 Suppressed and 

00FF in the FDL. The format selected is applicable to both the transmit side and receive sides. 
When B2 Suppressed is selected, the format for the yellow alarm is a ‘0’ in bit 2 (2nd MSB) of all 
channels.  When 00FF in FDL is selected, the format for a yellow alarm is a repeating sequence of 

OOFF (hex) on the 4 KHz facility data link (FDL). 
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Auto detection of B8ZS / Change-of-Frame alignment 

This option enables the receive side of the hardware to automatically detect either B8ZS codeword or 

Change-Of-Frame Alignment (COFA).  Setting this option to B8ZS is advisable if there is a suspicion 

that the remote transmitter is set for B8ZS. If timing slips are suspected, then setting this option to 
COFA is advisable. A COFA is reported when a receiver resync results in a change of framing or multi-
framing alignment. 

 Note: 

This feature has been disabled for USB T1/E1 and t Probe™ Analyzer. 

Jitter Attenuation and Jitter Attenuation Bandwidth 

This menu has three selections, which enable or disable the jitter attenuation block of the line interface 
unit. Selection of the Jitter attenuation in the receive path will allow the receiver to accept more jitter 
at the receiver input as per the receiver tolerance specifications. Selection of the jitter attenuation in 

the transmit path will place the jitter attenuator in the transmit path to reduce the transmit jitter. The 
disabled selection will remove the jitter attenuator from the ‘transmit and receive’ sides of the line 
interface. 

 

 Note: 

Jitter Attenuation Bandwidth feature has been disabled for USB T1/E1 and t Probe™Analyzer. 

 

CRC-6 Calculation (193E): 

This menu selection allows the user to select between the CRC-6 calculation method used in T1 and J1. 

The selection of ANSI/AT&T/ITU will enable the CRC-6 calculation used in traditional T1-ESF circuits 
found in North America. The selection of JT.G704 will enable the CRC-6 calculation used in J1-ESF 
Circuits found in Japan. 

Signaling Onhook/Offhook  

This is defined by configuring the ABCD signaling bits. Other modules in the analyzer application use 
these settings. 
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4.4.4 Device Selection 

When you click on the Device Selection Tab the setup for DpciHdE1 dialog box opens as shown in the 
figure below. Here you have the option to select cards from Card#1 to Card #16 to transmit signals 

(for onhook/offhook) 

 

Figure 28: Device Selection Tab 
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4.5 WCS Configuration 

User can set the WCS Server to start with default  values at analyzer start-up.  Click Config > WCS 
Configuration menu to open the Launch pad as shown in the figure below. The Launchpad program 

also allows you to specify which TCP/IP port should be used to listen for incoming connection requests 

from clients, as well as the messaging options (ASCII or binary, version 3 or 4) that will be used by the 
Server.   

 

Figure 29: WCS Settings 

The various controls in Launchpad's main window are: 

Listen Port:  This is the TCP/IP port on which the server should listen for incoming connection 
requests from clients.  Default values are 17080 for T1 systems and 17090 for E1 systems.  If these 

ports are not available on your machine, you may select another port. 

Restore Default:  This button is inactive if the Listen Port box contains the default listener port.  If 
the listener port has been changed to some other value, you can restore the default value by pressing 
this button. 

Default IP Address: WCS launchpads recognizes the local IP address as default listener IP address. 
Generally, this address is 127.0.0.1. This address can be named explicitly by clients wishing to connect 
to WCS Servers that have been launched using the "<Default>" listener IP Address. 

Send / Receive Binary Messages: Indicates that the server is to communicate with clients using 
binary messages. 

Send / Receive ASCII Messages: Indicates that the server is to communicate with clients using 

ASCII (text-based) messages. 

Send / Receive Version 3 Messages: Indicates that the server is to communicate with clients using 
version 3 messages.  In this format, messages are transmitted without a length field. 

Send / Receive Version 4 Messages: Indicates that the server is to communicate with clients using 

version 4 messages.  In this format, messages are comprised of a message length field followed by the 
message itself. 

Use these settings Until Further Notice: Enable this option to use the current configuration settings 
as default settings at analyzer startup. 

Start Server Automatically At analyzer Startup: It will start the WCS server at analyzer startup by 
default. 

For more information on WCS Server refer to T1E1 Client Server User’s Manual. 
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Section 5.0 Detailed Description of View Menu Functions  

A typical View Menu is as shown in figure given below. 

 

Figure 30: View Menu 
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5.1 Tool Bars 

5.1.1 Monitor Toolbar 

Checking Monitor under View > Toolbar menu displays a list of short cut tool bar for monitoring 

applications as shown in the figure  

 

Figure 31: Monitor Toolbar 

 

 Note: Removing the check against the Monitor in the View > Tool Bar menu hides this toolbar. 

 

5.1.2 Intrusive Tests Tool Bar 

Checking Intrusive test under View > Toolbar menu displays a list of short cuts as a tool bar for 

Intrusive test applications as shown in the figure below 

 

Figure 32: Intrusive Test Toolbar 

 

 Note: Removing the check against the Intrusive tests in the View > Toolbar menu hides this toolbar. 
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5.1.3 Special Applications Tool Bar 

Checking Special Applications under View > Toolbar menu displays a list of short cuts as a tool bar 
for Optional software applications as shown in the figure below 

 

Figure 33: Special Applications Tool Bar 

 Note: Removing the check against the Special Applications in the View > Toolbar menu hides this toolbar. 

 

5.1.4 Protocol Analyzers Tool Bar 

Checking Protocol analyzers under View > Toolbar menu displays a list of short cuts as a tool bar 
for protocol analyzer applications as shown in the figure below  

 

Figure 34: Protocol Analyzers Tool Bar 

 Note: Removing the check against the Protocol Analyzer in the View > Toolbar menu hides the toolbar. 
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5.2 Card Settings Dialog Bar 

 

Figure 35: Set up Dialog Bar for USB card 

The ‘Setup Dialog Bar’ when checked, displays the selections for Framing Format, Termination, B8ZS. 

 

5.2.1 Framing Formats for T1/E1 Systems 

5.2.1.1 Framing Formats for E1 Systems: 

 

 

Figure 36: Framing Format for E1 

Channel Associated (CAS) or Common Channel Signaling (CCS) Framing Formats 

GL’s E1 Cards permit either Channel Associated Signaling or Common Channel Signaling modes. In 

CAS mode, timeslot 16 contains signaling bits for each channel. In CCS mode, timeslot 16 does not 
contain signaling information, it may contain user defined and formatted data. 

Receive and Transmit CRC-4 Multiframe Formats 

Two separate multiframe structures exist in CEPT environments:  CRC-4 and Channel Associated 
Signaling (CAS). Both these multi-frames use the frame structure but when used together they may 
not be aligned. 

The CRC-4 multiframe consists of a multiframe alignment word and two 4-bit code words.  The CRC-4 

multiframe always begins on an align frame and utilizes the spare international bit (bit 1 of both align 
and non-align frames).  The CRC-4 multiframe alignment word is a repeating 6-bit code (001011), 
which is located in odd frames 1 through 11. Each CRC-4 multiframe is divided into two sub multi-
frames. Each sub multi-frame consists of eight frames and it contains one 4-bit CRC-4 code word.  

Each code word represents a data check on eight frames of data i.e. 2048 bits. The two 4-bit code 
words are located in the even frames.  The CRC4 multiframe is used primarily to assist in validating 
alignment at the FAS level but could also be used to monitor error performance.  CCITT recommends 

that whenever more than 914 CRC4 blocks out of 1000 are received in error, then it should be 
assumed that a false alignment at the FAS level has occurred. 

Unframed Formats 

In unframed mode over E1, the application allows overwriting TS0 so that user can use all the 
timeslots from 0-31, thus providing full 2.048-Mbps bandwidth. 

Once the framing format is modified to Unframed E1, all applications are automatically set to work in 

ths mode. This mode enables Tx on TS0 and disable auto resync on Rx.  
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5.2.1.2 Framing Formats for T1 Systems  

Currently two framing formats are supported: 193S and 193E as shown in the figure below. The 193S 

format is also referred to as the D4 framing format and the 193E format is also referred to as the ESF 

format. 

 

Figure 37: Framing Format for T1 

193S (D4) Framing Format 

In the 193S-framing format, the framing bit position is used for two purposes. The odd F-bits, 
designated as Ft (terminal framing) bits always carry a repeating pattern of ‘101010’. This pattern is 
used for distinguishing frame boundaries and for distinguishing even and odd frames. The even F-bits, 
designated as Fs (signaling framing) bits carry a different sequence (001110), which identifies 
multiframe boundaries.  There are 12 frames per multiframe in the 193S format.  Signaling information 
associated with each individual voice channel, such as on-hook/off-hook, call progress, and dial digits 

are transmitted within the voice channel in the LSB of each channel's codeword during the 6th and 
12th frames. This technique, known as ‘robbed-bit’ signaling, replaces the LSB of the PCM codeword 
with the signaling data.  The signaling state in the 6th frame for each channel is known as the A bit. 
The signaling state in the 12th frame of each channel is known as the B bit. For voice grade 
applications, robbed-bit signaling does not noticeably degrade the signal quality. For data applications, 
selecting transparent mode can disable robbed-bit signaling. 

193E (ESF) Framing Format  

The 193E or Extended Super frame Format was developed to utilize the framing bit capacity for 
additional purposes.  The number of frames per multiframe is expanded to 24 frames. This multiframe 

is also called a super frame.  The 24 framing bit positions of each are divided into 3 channels. The FPS, 
or Framing Pattern Sequence, provides a synchronization signal for determining frame and super frame 
alignment.  A 4kHz Facility Data Link (FDL) provides a dedicated channel for system messages. The 
Cyclic Redundancy Check (CRC) channel allows checksums to be transmitted with each super frame to 
monitor line quality. According to the 193S format, every 6th frame is designated as a signaling frame.  
The signaling frames are frames 6, 12, 18, and 24 and carry the A, B, C, and D signaling states.  To 

maintain compatibility with the 193S format, C = A and D = B is often assumed. 

 

5.2.2 Terminate, and Monitor Interface Options 

The input signal (the signal connected to the ‘T1/E1 In’ jack) may be terminated using impedance, 
monitored, or bridged depending on user requirements. (Refer to the figure below.) 

 

Figure 38: Terminate, Bridge, Monitor Options 

 Terminate  

The incoming signal is electrically terminated in 100 ohms for T1 signals, 120 ohms for E1 signals. This 

form of connection is normally used when connecting directly to a T1/E1 signal rather than monitoring 
a signal on an existing T1/E1 connection. 
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 Monitor 

The incoming signal is assumed to originate from a monitor jack (which provides a tap and a pair wise 

series resistance of 420 ohms). On the board, the signal is terminated with either 100 Ω (T1) or 120 Ω 
(E1) resistance. This form of connection is normally used to non-intrusively monitor transmissions on 

an existing T1/E1 connection. A monitor signal is usually at a level of-20 dBsx that is 20 dB down from 
the nominal signal level measured at a DSX panel. 

The interfaces to the T1/E1 Cards or Portable USB Units are balanced 120 ohm (E1) or balanced 100 
ohm (T1) electrically. Systems employing 120-ohm interfaces can connect directly to the Cards or 
Portable USB Units. When connecting to systems employing 75-ohm interfaces, as is sometimes 
encountered in E1 systems, a 120-to-75 ohm transformer may be used. Contact GL Communications 
for these adapters. Connecting an unbalanced 75-ohm signal to a balanced 120-ohm interface (using a 
BNC to Bantam cable) will generally work for short distances. 

 

 
 

  

Figure 39:Monitor Mode  
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5.2.3 B8ZS On/Off (T1 cards only) 

Refer to section B8ZS zero substitution for complete details on B8ZS substitution. 

 

5.3 T1E1 Line Status Monitor 

The line status window indicates if the T1or E1 line is either up, or down. The Alarms section exactly 
shows what type of problem maybe present on the line. The presence of any alarms indicates a serious 
problem on the line. The Statistics section provides the exact measurements of framing errors, Slips, or 
line code violations. These measurements help you verify the physical integrity of the T1 line, and to 
ensure that there sare no framing errors, slips, or line code violations. 

Monitor T1/E1 Line windows gives a detail description of all alarms and line conditions in the 
‘Monitor’ panel for all the available T1/E1 Cards installed on local PC. 

 

5.3.1 Legends:  

Active: 

Whenever any alarms are active, a RED cross mark  is displayed against the card informing about 

the alarms status. 

 

Not Active: 

If no alarms are detected on E1/T1 link, then this will be shown with a Green check mark  for the 

corresponding card. 

 

History: 

When any of the alarm is detected and then switches to no alarm state, then the  alarm is considered 

as History and will be shown with Yellow ‘ ’mark.  

 

The following indications are provided: 

 

 

Figure 40: Monitor T1E1 Line Status  
 

5.3.2 T1/E1 Alarms 

Line Sync Loss: 

This will flash when a receiver resync is in progress. If the receiver is set to auto resync in the 
Configuration Menu, the receiver will begin resync when an OOF (Out Of Frame) event or Loss of 
Carrier is detected. 

 

HDB3 Violations (E1 Only):  

High Density Bipolar 3(HDB3) is a ternary transmission code in which the number of consecutive zeros, 
which may occur, is restricted to three, to ensure adequate clock recovery at the receiver. In any 
sequence of four consecutive binary zeros, the last zero is substituted by a mark of same polarity of 
the previous mark, thus breaking the Alternate Mark inversion (AMI) code. This mark is termed as 
violation. 
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Bipolar Violation (T1 Only): 

Bipolar violations are recorded within the frame chip in an 8-bit Counter. This light will flash to RED 

whenever new bipolar violations are detected. 

 

Carrier Loss: 

Carrier loss alarm is declared when 128 ± 1 consecutive zero's are detected. Carrier loss clears when a 

‘1’ is received. 

 

Frame Error: 

This will flash whenever a framing bit is in error. For T1 systems, in 193S mode, the Ft bits are 
monitored (odd F-bits).  In 193E mode, FPS bits are monitored (F-bits of frames 4, 8, 12, 16, 20 and 
24).  For E1 systems, framing bit errors are detected in timeslot 0. 

 

Remote Alarm Detected (E1 Only): 

This will flash when a remote alarm is detected. A remote alarm is defined as the reception of three 
consecutive bits equal to ‘1’ of timeslot 0 of non-align frames.  

 

Distant Multiframe (MF) (E1 Only): 

This indication will flash when a distant multiframe alarm is detected. A distant multiframe alarm is 

defined as the reception of three consecutive 1s at bit position of timeslot 16 in frame 0. This indication 
is only valid when in CAS mode. 

 

Blue Alarm (T1 Only): 

This will flash when a blue alarm is detected. A blue alarm is defined as the reception of unframed all 
ones condition.  The algorithm used is to simultaneously check for an out-of-frame (OOF) condition, 

and check for 14 or less zeros out of 13,895 bits. All bits, including framing bits, are tested.  The alarm 
is cleared if OOF condition clears, or if 15 or more zeros are counted within 13,895 bits. 

 

Yellow Alarm (T1 Only): 

This will flash when a yellow alarm is detected.  The format of the alarm detected is determined by the 
framing format and the settings in the Config Menu. 

When the format for the yellow alarm is specified as bit 2 suppressed in 193S or 193E mode, a yellow 
alarm is defined as a ‘0’ in bit (2nd MSB) of every DS0 timeslot for 256 or more consecutive timeslots.  
The alarm clears when a ‘1’ is detected in the bit 2 position of any timeslot. 

If the yellow alarm is specified as FDL yellow alarm in 193E mode, then a yellow alarm is declared after 
16 repetitions of ‘00FF’ on the FDL. The alarm clears with the detection of any bit, which violates the 
sequence. 

If the yellow alarm is specified as the S-bit yellow alarm in 193S mode, then a yellow alarm is declared 

whenever a ‘1’ is detected in the F-bit of frame 12.  The alarm is cleared when a zero is detected in the 
F-bit of frame 12. 

 

Alarm Indication Signal (AIS): 

The receiver detects an AIS pattern when it receives less than three zeroes in any string of 2048 bits.  
The AIS condition is cleared when three or more zeros are detected in 2048 bits. 
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5.3.3 T1/E1 Statstics 

Signal Inputs 

Frequency: This shows the T1/E1 line frequency in Hertz (Hz)  

Level: This shows the T1/E1 line power in dBm  

 

Error Counters 

BPV: 

This provides a counter for the BPV alarms. Uses an eight bit counter 

OOF: 

This provides a counter for the Out of Frame alarms. Uses an eight bit counter 

Frame: 

This provides a counter for the frame errors. Uses an eight bit counter 

CRC: 

This provides a counter for the CRC errors. Uses an eight bit counter 

Transmit Under Run: 

Tx Underrun is indicative of multiframe(s) transfer problem from PC to the T1/E1 Analyzer. Whenever 
this error happens, T1/E1 Analyzer starves data for transmission and so previous multiframe(s) will be 

sent on T1/E1. 

Receive Over Run: 

Rx Overrun is indicative of multiframe(s) transfer problem from T1/E1 Analyzer to the PC. Whenever 
this error happens, PC/Application will lose multiframe(s) from the T1/E1 Analyzer. 
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5.3.4 T1/E1 Alarms Logging 

Checking ‘Alarm Logging’ option will log all the alarms to a log file (.csv). The log file will have all the 

information about the alarms: such as date, time, and active/inactive state. The file logs the Rx 

frequency at the beginning and end of logging. Refer to the figures below 

 

Figure 41: T1/E1 Alarms Logging 

 

Figure 42: T1/E1 Alarms and Statistics in CSV Format 
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5.3.5 Graph 

The Graph option in T1E1 Monitor Bar displays the real-time port-wise status of all alarms and frame 
errors such as SyncLoss, Bipolar, CarrierLoss, FrameError, BlueAlarm, YellowAlarm, AIS, BPVErrors, 

CRCErrors, and FrameErrors. Users can choose to display only selected or all alarms to be displayed in 
the graph. This real-time graph data is.also automatically saved in the installation directory 
("T1E1AlarmGraph" folder) every one hour or when the analyzer application is closed. The saved file 

can be opened later for offline analysis. 

Online Graph 

 In the T1E1 Monitor Bar, Check Enable Event Graph to enable Online Graph option 

 Click on Online Graph option to display the Realtime T1E1Monitoring Graph window as shown 
in the figure below.  

 

Figure 43: Alarm Status of Port #1 to #16 are Displayed in Graphical Format 

 Real-Time Display – Check this option to display the current status of alarms. 

 Graph Duration – Graph is displayed for selected duration time. 

 Clear – It will reset the graph 

 Show/Hide Legend – This will show or hide the alarm legends below the graph.  

 Port #1 – Displays the alarm status on Port #1. 

 Port #2 - Displays the alarm status on Port #2. Simlarly, displays alarm status for all the other 

ports. 

 

Offline Graph : In the T1/E1 Monitor bar, click on Offline Graph option to open saved *.egf files. 

 

5.4 Status Bar  

Status Bar is displayed in the lower right hand corner. It displays one of following status: 

 

#1 T1/E1 In Sync: 

Displayed in the lower right hand corner, indicates that the T1/E1 signal is in sync. 

 #2 T1/E1 In Sync 

 #3 T1/E1 In Sync 

 #4 T1/E1 In Sync 
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#1 T1/E1 Sync Loss: 

Displayed in the lower right hand corner, indicates that the T1/E1 signal is not in sync. 

 #2 T1/E1 Sync Loss 

 #3 T1/E1 Sync Loss 

 #4 T1/E1 Sync Loss 

 Not Running is displayed in the lower right hand corner, indicates that the interrupts are not 

being received or processed properly. Exit and re-enter the T1/E1 Analyzer application. If this 
does not correct the problem, contact GL Communications. 

 Ready is displayed in the lower left hand corner, indicates that the T1/E1 Analyzer application is 
initialized properly. 
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5.5 Diagnostic Applications 

The features under this menu are only useful for factory diagnostics. End users are not expected to 
know the detail specifications of these registers. Hardware Registers permits viewing of the settings of 

the framer, driver, TX and Rx codecs, and the I/O port registers. Application FPGA Registers includes 

registers useful during remote debugging. The registers are built into the application Xilinx (a control 
block for most operation conducted by the board) and help in controlling various settings on the board 
that affects the logic operations applied to the T1/E1 stream. When the user applies certain settings, 
applications manipulate these registers. 

Following are the registers included with the application for diagnostic and remote debugging: 

 tScan PCIe Express Card 

Hardware Registers  

Driver Info Yes 

Application FPGA Registers Yes 

DMA FPGA-Board  

DMA FPGA-Port  

DMA FPGA  

DMA FPGA Registers  

Framer Registers  

Codec Registers  

LIU and Framer Registers USB NG  

Codec Tx Registers  

Codec Rx Registers  

Datacom Registers  

Parallel Board Registers Yes 

Serial Board Registers Yes 

Atmel  

APP-FPGA - Board  

APP-FPGA - Port  

DS2155  

Tx Codec  

Rx Codec  

Univ/Octal Board Registers  

AD9833  

DS21458  

ATM Registers Yes 
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Section 6.0 Detailed Description of Monitor Menu Functions 

6.1 Monitor Byte Values 

This box displays the data values for each time slot in HEX data format. These values will be changing 
very rapidly, as each timeslot's data rate is 8000 bytes/sec. Refer to the figure below for a typical view. 

 

Figure 44: Display Byte 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 
ports in the Breakout Box and invoke ‘Byte Values’ on the connected card to view transmitted bytes. 

Now, transmit a tone on card #1 from the DUT, timeslots 1-10. The byte values should appear 
changed only in the timeslots into which a tone is being transmitted. Refer to the above figure. 

 Note: 
 To know the RJ45c port numbers in the Breakout Box refer to the section Breakout Box 

 

 

6.2 Monitor Binary Byte Values 

This box displays the data values for each time slot in binary data format.  These values will be 
changing very rapidly as each timeslot's data rate is 8000 bytes/sec. Refer to the figure shown below: 

 

Figure 45: Display Binary Byte 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 
ports in the Breakout Box and invoke ‘Transmit Multiframe’ on card #1 for timeslots 1 to 10 from the 
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DUT and transmit binary value of AA (10101010). Verify whether the same byte values are received in 
‘Display Binary Byte’ on the connected port in the Breakout Box. 

 

 

6.3 Monitor Signaling Bits 

The signaling bits associated with each timeslot are displayed in real-time as shown in the figure. 

For T1 cards, the received signaling bits A and B for 193S (D4 Framing Format) and A, B, C, and D for 
193E (ESF Framing Format) are displayed for all channels.  

For E1 Cards, this application should be used in CAS mode only. The signaling bits A, B, C, and D are 
displayed for all channels. These bits are demultiplexed from timeslot 16. 

 

Figure 46: Signaling Bits 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 
ports in the Breakout Box and invoke ‘signaling bits’ on the connected port in the Breakout Box. 

Transmit all the signaling bits listed on timeslot 1 of card #1 from ‘Tx Signaling bits’ application. 
Observe that the signaling bits change on ‘Signaling Bits’ display when they are transmitted. 

 

6.4 Monitor Power Level (in dBm)  

The rms (root-mean-square) value of the digital codewords (after expansion from µ-law or A-law) for 
each timeslot is computed and continuously displayed in dBm. The number of samples used in the 
computation is 192. 

 

Figure 47: Power Level 
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Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 

ports in the Breakout Box and invoke the ‘Power monitoring’ window on the connected in the Breakout 
Box and transmit the tone on all or several timeslots on card#1. Observe the same power value in the 

power level display; change the power level of the tones being transmitted and observe the 
corresponding changes power level display. 

 

6.5 Monitor DC Offset  

The measure DC Offset application provides the capability to measure and display DC offsets for all 
timeslots. Multiple instances of this application may be opened simultaneously to monitor DC offsets on 
more than one GL card. Select the card to monitor from the drop-down list in the Card # box as shown 
in the figure below. 

 

Figure 48: DC Offset 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 

ports in the Breakout Box and transmit Gaussian noise on few timeslots from the DUT and observe the 
DC offset values changing consistently on the connected port in the Breakout Box. 
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6.6 Monitor Frequency  

A continuous display of the signal frequency in each timeslot is displayed. The frequency is computed 
using the zero-crossing rate of the samples from each channel. The number of samples used in the 

calculation is 4000. 

 

Figure 49: Frequency 

Example: 

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 

ports in the Breakout Box; transmit a tone of 1004 frequency on card1. Enable ‘frequency sweep’ 
option by a measure of 100 on frequency step. Tx the tone from the DUT and observe the frequency 
measurement in the frequency display on the selected port in the Breakout Box. As the frequency 
changes periodically, observe the corresponding changes on the frequency display.  
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6.7 Monitor Multiframes 

This application permits viewing multiframes for all timeslots.  

Approximately 2 seconds of data is captured,  

Or  

682 multi-frames in T1 ESF/193E,  

1364 multi-frames in T1 D4/193S,  

1024 multi-frames for E1 are captured.   

The data is displayed with each frame identified.  

For T1 systems, twelve (12) frames are displayed per multiframe in D4 (193S) framing format, and 
twenty-four (24) frames in ESF (193E) framing format.   

For E1 systems, 16 frames are displayed per multiframe. 

 

Figure 50: Rx Multi-frames  

New Data: 

Clicking New Data refreshes the data displayed. 

MF #:  

Any multiframe within one second of captured data can be selected and observed 

Device Selection: 

Allows the user to choose either card1 or card2 to capture data  

Example  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 

ports in the Breakout Box; observe the captured data on the multiframe display on the connected port 
in the Breakout Box. Press ‘New Data’ to refresh the display or change the ‘MF #’. 
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6.8 Monitor Real-time Multi-frames 

This application permits viewing of multi-frames in real-time. The data is refreshed for about every 
second. For T1 systems, twelve frames are displayed per multiframe in D4 (193S) framing format. 

Twenty-four (24) frames are displayed in ESF (193E) framing format.  For E1 systems, 16 frames are 
displayed per multiframe. 

 

Figure 51: Real-time Multi-frames 

Receive Data: 

Clicking this permits the reception and display of real-time data. 

Stop Data: 

Clicking this option will not receive the further data. 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 

ports in the Breakout Box and transmit BER pattern on card1 using Intrusive Test – Bit error Rate test; 
observe the real-time data changing continuously on the Rx Multi-frames display of the connected port 
in the Breakout Box. 
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6.9 T1 (E1) Data as Real-time Bitmap 

This application permits a graphical view of complete multi-frames as a real-time bitmap. A snapshot of 
several multi-frames of data is obtained at a given instance and the view is rendered as a pixel map 

with zeros represented by white dots and ones represented by black dots. 

 

Figure 52: Real-time Bitmap View 

For T1 systems, twelve (12) frames are displayed per multiframe in D4 (193S) framing format, and 
twenty-four (24) frames in ESF (193E) framing format.  For E1 systems, 16 frames are displayed per 
multiframe. 

Toolbar Options: 

 

Figure 53: Tool Bar Options 

Play: Click Play to start continuous refreshing of the bitmap. By default the refresh interval is 1.5 
seconds. 

Pause: Click Pause to Stop continuous refresh. 

Refresh: Click refresh to refresh the bitmap once. 

Card Selection: Select the card from which the multi-frame data is obtained. 

Timeslot Selection: Click All or None to select or deselect all timeslots for display. Use the individual 
timeslot selectors to show or hide single timeslot data. 

Applications: 

 On GSM networks to monitor A-bis link for TRAU traffic. 

 To understand the pattern of HDLC traffic over T1/E1. 

 For a quick view of signaling bits activity. 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 
ports in the Breakout Box transmit a tone into a timeslot (or timeslots) of your choice from the DUT; 
observe the captured data in the bitmap display on the connected port in the Breakout Box.  You can 
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also continuously send an HDLC file on specified timeslots from the DUT. Observe how HDLC flags are 
clearly shown on the bitmap display. 

6.10 Monitor Timeslots  

This window displays the timeslot value for about ‘2’ second duration for a desired timeslot.  Ability to 

change the particular timeslot is also provided. ‘New Buffer’ button allows refreshing of the data. The 
‘Timeslot Window’ module differs from ‘Multiframes’ module, in which all the multiframes for a 
particular timeslot are displayed. 

Data of about 2seconds duration is displayed.  

In ‘Multi-frames’,  

T1 D4/193S: 1364 multiframes are displayed 

T1 ESF/193E: 682 multiframes are displayed 

E1:   1024 multiframes are displayed 

 

Figure 54: Timeslot Window 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 

ports in the Breakout Box, transmit a tone of 1004 frequency on card1. Enable ‘frequency sweep’ 
option by a measure of 100 on frequency step. Transmit the tone and observe the data is being 
captured in the timeslot display on the connected port in Breakout Box. As the frequency changes 
periodically observe the corresponding changes. Click ‘New Buffer’ to refresh the display or change the 
TS #. 
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6.11 ASCII Timeslot Display 

This application permits viewing of real-time ASCII events that are present on the tScan T1 or E1. The 
ability to display the ASCII events for a particular port and timeslot is provided. Each event is properly 

time-stamped for tests that require time correlation. Logging real-time events to the hard drive is also 
possible; this is useful during overnight or long-term testing. 

 

Figure 55: ASCII Timelsot Display 

Timeslot Display Pane 

Timelsot display area displays the records in most recently received order.  

 Time - displays date and time of the message received at Probe. 

 Message – displays the exact contents of ASCII portions of message, or duration of Idle 
segments if selected.  

Data Source 

Port: The drop-down Port Selector allows users to select the port on which the data will be received. 

Timeslot: The spinner at the right of the Timeslot Selector allows users to select the timeslot on which 
the data will be received, or users can key in the timeslot number directly. 

For E1 Systems, Timeslot 0 disallowed and Timeslot 16 is available only for CCS signaling modes.   

Options 

Display Idle: Select this button to display and optionally log Idle Code records.  Release this button to 

display and optionally log non-Idle message content only. 

Enable Logging: Select this button to log messages and optionally log Idle Code records to a file.  
Release this button to disable logging. 

Start / Stop Run  

Select Run button to start capturing the events.  The indicator LED will flash green when a Run is in 
progress 

Release Run button to stop capturing of events.  The indicator LED goes dark when the Probe is in 
Ready status. 
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6.11.1 Timeslot Display Options 

This interface allows users to set the number of captured ASCII events in the display area, log file into 
the desired path, and select the Reverse Bit Order option. 

 

Figure 56: Timeslot Display Options 

Display Options 

Users can set the maximum number of lines to be retained in the Display Window using the Display 

Limit spinner, or users can key in the number of lines directly. A maximum of 30000 lines and a 
minimum of 20 lines can be retained in a display area. Modifying the number of lines does not affect 
the Log file. 

Data Options 

Reverse Bit Order: Check this option if the remote data transmitter transmits bits in MSB to LSB 
order.  Selecting this option reverses the bits before being examined for messages. 

Idle Code: Enter the Idle Code value used to separate the messages.  Ensure to reverse the bits if the 
Reverse Bit Order box is checked. 

Log File 

Use the Browse button to save the log file in a desired path. The log file will be saved only if Enable 
Logging option is selected. 

Click OK button to save the changes and thus closes the Timeslot Display Options dialog. 

Click Cancel button to discard the changes and thus closes the Timeslot Display Options dialog. 

 

6.11.2 Status Bar 

 

Figure 57: Status Display 

System Status 

 Ready:  The system is in standby mode. 

 Running:  Timeslot monitoring is in progress. 

Log File Status 

 Log Enabled: Results will be recorded in a Log File. When a Run is in progress, the name of the 

Log file is displayed here. 

 Log Disabled:  Results will be displayed in the Timeslot Display only. 

Monitoring Message 

Displays the messages produced by the Timeslot Monitor. 

 - Displays the system time and date. 
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6.12 Oscilloscope Display 

The PCM codes (amplitude of the incoming signal) of any selected timeslot are displayed in real-time 

graph as a function of time. Timeslot selection and time base can be changed to either view different 

incoming timeslots or modify the duration of the display.  The time base can be adjusted from 
approximately 0.005 sec full scale to 1.000 sec full scale. This application can be used to visually 
assess activities on the channel such as noise, tone, speech, etc.  The data may be displayed for all 
signaling formats – alaw, mulaw, pcm16, pcm13, pcm14, pcm8, and different byte order for INTEL 
(Little Endian), and MOTOROLA (Big Endian). 

Display Control: 

The graphical display in Oscilloscope can be magnified and moved by changing the time-base scale 
depending on the maximum and minimum limits. Further the oscilloscope window can be moved and 
resized as any other standard window. 

 

Figure 58: Oscilloscope Display 

Card #: 

Select the card here if operating with more than one card. 

Time Slot: 

Select the timeslot to be monitored here.  You can use the spin control to advance through the 
timeslots, or key in the desired time slot directly. 

Time Base: 

Select the duration of the time displayed. A minimum value of 0.005 sec to a max of 1.000 sec is 
possible.  You can use the spin control to increase or decrease the time span, or key in the desired 

time directly. 
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Decode Options 

Click on Decode options button, this displays options to select Data Formats, Sample Rates, and 

Byte Orders.  

 

Figure 59: Oscilloscope Decode Options 

 

Data Format: 

 

aLAW: Default for T1 analyzer. 

muLAW: Default for E1 analyzer. 

PCM16:For 16-bit 8KHz signals, two consecutive timeslots are used.  The byte order in which the two 
bytes of 16-bit data is determined by the selection of INTEL or MOTOROLA byte order options.  

Similarly, For 16-bit linear, 16 KHz signals, four consecutive timeslots are used.  The lower-numbered 
timeslot pair carries the earlier 16-bit sample point in time, while the higher-numbered timeslot pair 
carries the later 16-bit sample point in time. The byte order is determined by the selection of INTEL or 

MOTOROLA options. The four timeslots, when used in this fashion, make up a four-byte hyperchannel.  

PCM13: Displays 13 bit data on two selected timeslots for 8KHz sample rate. Byte order is determined 
by the selection of INTEL or MOTOROLA options. 

PCM14: Displays 14 bit data on two selected timeslots for 8KHz sample rate. Byte order is determined 
by the selection of INTEL or MOTOROLA options. 

PCM8: Displays raw data on single timeslot without any decoding.  

 

Sample Rate: Sample rate option is available only for PCM16 data format. 8KHz and 16KHz sample 
rate options are available. 

 

Byte Order: Provides INTEL or MOTOROLA  byte order options. 

INTEL (Little Endian): The lower-numbered timeslot carries the least-significant byte (LSB), while 
the higher-numbered timeslot carries the most-significant byte (MSB) 

MOTOROLA (Big Endian): The lower-numbered timeslot carries most-significant byte (MSB), while 
the higher-numbered timeslot carries the least-significant byte (LSB). 

 

 

Hide Option: Click on Hide Options button to hide the decode options toolbar. 
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Options: 

Click Options, a drop-down menu appears. The various options are: 

 

Figure 60: Oscilloscope Options Display 

 Select Print Page option to print the Oscilloscope Display window on the current selected printer. 

 Select Print Graph option to print the graphic portion of the Oscilloscope Display on the current 
selected printer. 

 Select Printer Setup option to show the standard Windows Printer Setup dialog. 

 Select Printing Options to show the Print Parameters dialog, which allows you to specify the 

options for printing or copying graphs. 

 

Figure 61: Print Parameters 

 Select Copy Graph option to print the graphic portion of the Oscilloscope Display on the 

clipboard. 

 Select Copy Page option to print the Oscilloscope Display window on the clipboard. 

 Select Save as Metafile option to save the graph as a meta file. 



Detailed Description of Monitor Menu Functions 

GL Communications Inc. 60 August 2014 

Document Number: T1E1-8.7.28-03 

 Select Parameters to show the Graph Parameters dialog, which allows you to Control certain 
aspects of the graphic display such as its position, background color. Clicking BORDER 

ATTRIBUTES opens the Line Parameters dialog box as shown in figure below: 

 

Figure 62: Graph Parameters  

 Use this button to bring up the windows Print Setup dialog and print the graph 

Hot Spots 

Hot spots are specific regions on the graph that display various types of dialog boxes which can be 
used to set options for required display. These dialog boxes can be opened by double clicking a 
particular area of display. The various hot spots for Oscilloscope display are illustrated below: 

 Double click on vertical axis –to open Axis Labels dialog box. Clicking Text Parameters opens a 
dialog box where in you can change the different parameters as shown in the figure below.  

 

Figure 63: Axis Labels 
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 Double click on the vertical axis to open the Vertical Axis dialog box as shown in the figure 
below. 

 

Figure 64: Vertical Axis 

 Double click on the Horizontal Axis to open the Horizontal Axis dialog box as shown in the figure 

below. 

 

Figure 65: Horizontal axis 

 Double click on time axis, time axis graduation labels, and time axis label to activate the Time 
Labels dialog box as shown in the figure below. 

 

Figure 66: Time Labels 
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 Double click on the graph trace to activate the Graph Alarm dialog box as shown in the figure 
below. This dialog can be useful if you want to establish a horizontal reference line on the graph, 
and display a message, if the displayed trace goes above or below this line. Click Line Attributes 
or the Alarm attributes to change the different parameters. 

 

Figure 67: Alarm Lines 

Scrolling Graph: 

Double click on the graph after the signal is transmitted. You will see a Scrolling Graph dialog box as 
shown in the figure below. Here you can make changes by using different parameters. 

 

Figure 68: Scrolling Graph 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 

ports in the Breakout Box, transmit a tone of 1004 frequency on card1; observe the oscilloscope 
display for the desired timeslot on the selected port in the Breakout Box. Adjust the time base to get a 
clear representation of the sine wave.  
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6.13 Power Spectral Display 

The data received on a specified timeslot can be viewed in the spectral domain (spectral amplitude Vs 
frequency). A Fast Fourier Transform (FFT) is applied to successive sample sets of the incoming data 

and displayed graphically. Adjust the frequency resolution by the FFT length (from 32 points to 8192 
points). The data can be smoothed to lessen the effects of truncation by applying Hamming, Hanning, 
Harris, Blackman, Triangular, or Rectangular filter windows. 

 

 

Figure 69: Power Spectral Display 

In addition to power spectrum display of the incoming signal, the following computations are provided: 

 Signal-to-noise ratio for the highest single frequency tone.  The noise band can be adjusted to any 
range within the voice band. 

 Total noise power. 

 Tone power. 

 Tone frequency. 

 Total power. 

Power Spectral Display Settings: 

Display Control: 

The graphical display in Power Spectral Display can be magnified and moved by changing the 

Sample size depending on the maximum and minimum limits. 

Card #: 

Select the card, if operating with more than one card. 

Time Slot: 

Select the timeslot to be monitored here.  You can use the spin control to advance through the 
timeslots, or key in the desired time slot directly. 

Samples: 

The sample size upon which the FFT is computed can be adjusted from 32 samples to 8192 samples. 
The rendering improves in accuracy as the sample size is increased, at the expense of losing 

responsiveness to rapidly changing signals. 

FFT Window: 

The following smoothing filters are provided:  Blackman, Hamming, Hanning, Harris, Rectangular, and 
Triangular. 
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Decode Option 

Click on Decode options button, this displays options to select Data Formats, Sample Rates, and 

Byte Orders. 

 

Figure 70: Spectral Decode Options 

Data Format: 

 

aLAW: Default for T1 analyzer. 

muLAW: Default for E1 analyzer. 

PCM16:For 16-bit 8KHz signals, two consecutive timeslots are used.  The byte order in which the two 
bytes of 16-bit data is determined by the selection of INTEL or MOTOROLA byte order options.  

Similarly, For 16-bit linear, 16 KHz signals, four consecutive timeslots are used.  The lower-numbered 
timeslot pair carries the earlier 16-bit sample point in time, while the higher-numbered timeslot pair 

carries the later 16-bit sample point in time. The byte order is determined by the selection of INTEL or 
MOTOROLA options. The four timeslots, when used this fashion, make up a four-byte hyperchannel.  

PCM13: Displays 13 bit data on two selected timeslots for 8KHz sample rate. Byte order is determined 
by the selection of INTEL or MOTOROLA options. 

PCM14: Displays 14 bit data on two selected timeslots for 8KHz sample rate. Byte order is determined 
by the selection of INTEL or MOTOROLA options. 

PCM8: Displays raw data on single timeslot without any decoding.  

Sample Rate: Sample rate option is available only for PCM16 data format. 8KHz and 16KHz sample 
rate options are available. 

Byte Order: Provides INTEL or MOTOROLA  byte order options. 

INTEL (Little Endian): The lower-numbered timeslot carries the least-significant byte (LSB), while 
the higher-numbered timeslot carries the most-significant byte (MSB) 

MOTOROLA (Big Endian): The lower-numbered timeslot carries most-significant byte (MSB), while 
the higher-numbered timeslot carries the least-significant byte (LSB). 

 

Hide Option: Click on Hide Options button to hide Decode Options. 

 

Options: 

Click Options, a drop-down menu appears. The various options are: 
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Figure 71: Spectral Display 

Normal Display: 

Selecting this option causes the frequency spectrum of the incoming signal to be repeatedly calculated, 

and displays the calculated spectrum by updating. 

Averaging Display: 

Selecting this option opens up the Spectrum Averaging dialog box. In this dialog, specify how the average is to be 
calculated.  Once you have specified a value, the display is averaged over time in accordance with the parameters 
provided.  

 

Figure 72: Spectrum Averaging 

Peak Hold Display: 

Selecting this option will retain the max peak value of the samples plotted. 

Parameters: 

Selecting this option opens up the Graph Parameters dialog, which allows the user to control certain 

aspects of the graphic display such as its position, background color, and border attributes as shown in 
figure. 

Grid Lines: 

Selecting this option toggles the appearance of grid lines on the display. When checked, the grid lines 
appear in the graphic portion of the display. When unchecked, grid lines are not displayed. 
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Noise Band: 

Selecting this option opens up the Noise Band Range dialog box. Noise band is defined as the range 

of frequencies over which the power is calculated to determine noise power and the signal-to-noise 
ratio. The default frequency is 300 Hz to 3400 Hz. The Noise Band Range is marked in the Spectral 

Display, refer to the figure below: 

 

 

 

Figure 73: Noise Band Range 

Refresh Legends: 

This option is useful if the Legends (power and frequency measurement labels) have been over written 

by the graphic display. 

 Select Print Page option to print the Power Spectral Display window on the current selected 
printer. 

 Select Print Graph option to print the graphic portion of the Power Spectral Display on the 

current selected printer. 

 Select Printer Setup option to show the standard Windows Printer Setup dialog. 

 Select Printing Options to show the Print Parameters dialog, which allows you to specify the 

options for printing or copying graphs 

 Select Copy Graph option to print the graphic portion of the Power Spectral Display on the 
clipboard. 

 Select Copy Page option to print the Power Spectral Display window on the clipboard. 

 Select Save as Metafile option to save the graph as a meta file. 

 

 
 Click this button to display the Windows Print Setup dialog box and print the graph 

 

Hot Spots 

Hot spots are specific regions on the graph that display various types of dialog boxes which can be 

used to set options for required display. These dialog boxes can be opened by double clicking a 
particular area of display. This can be useful especially if you have resized the display and can no 
longer see axis labels and graduations clearly, and wish to enlarge only the labels or graduations. 
Slightly reframe this. The various hot spots for Power Spectral display are explained below: 

 Double click on the Vertical axis, vertical axis graduation labels, and vertical axis label to activate 

the respective dialog box. 

 Double click on the Time axis, time axis graduation labels, and time axis label to activate the 
respective dialog box. 
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 Double click on the graph trace to activate the graph Alarm Lines dialog box. This is useful, if you 
want to establish a horizontal reference line on the graph and display a message, if the displayed 
trace goes above or below this line. 

 Legends are the labels provided with the computed power measurements and displayed in the 

upper right of the graphic display area. Double click in this area to open a Legend Parameters 
dialog box. Do the changes if necessary. For example click ‘Text Parameters’ if the displayed 
measurements are too small to read clearly. 

 Double-click any of the power or frequency measurements and click ‘Text Parameters’ if the 

displayed measurements are too small to read clearly. 

Example:  

Cross-connect loopback cable to port #1 of T1/E1 Cards (DUT) and to any of the Equipment RJ45c 

ports in the Breakout Box, transmit a tone of 1004 frequency on card1, and observe the spectral 
display for the desired timeslot on the selected port in the Breakout Box. Adjust the sample size to 
increase or decrease the resolution of the spectrum of the sine wave. Experiment with options of the 
spectral display. 
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6.14 Monitor Active Voice Level Measurement 

Overview 

The Active Voice Level Monitor computes the Active Voice Level—what does this signify of a signal 

according to the ITU-T P.56 specification, Method B.  The user can obtain and analyze the source signal 

in real time from T1/E1 timeslots, or can process signal data captured to files as an offline process. 

 

Figure 74: Active Voice Level Measurement 

Theory of Operation 

For complete information on the calculation of Active Voice Level, see ITU-T Recommendation P.56 
Objective Measurement of Active Speech Level. The section that follows below contains a 
paraphrase of that document, as well as some details regarding this implementation. 

The Active Voice Level and associated measures such as Activity Factor are computed through the 
following processes, which operate in parallel: 

The sample count, sum, and sum squared signal value are tracked.  At any given time, the values so 

tracked are available to other processes. 

Amplitude ‘envelope’ is computed. The envelope is essentially a smooth average of absolute sample 
values, with recent samples given greater weight than those in the more distant past. 

Fifteen fixed amplitude thresholds are established, the highest of which is half the full-scale amplitude.  
Each successive threshold is half of the previous one.  For each amplitude threshold, data are kept 
concerning the number of samples for which the amplitude envelope (computed by process 2) exceeds 
the threshold, a quantity called the ‘activity count’. A 200 ms ‘hangover time’ is also applied at each 
threshold to bridge momentary pauses in speech. The signal is considered ‘active’ with respect to that 
level if either the envelope value is above the threshold or the hangover time has not expired. 

At any given time, the active voice level is found as follows:  

For each successive threshold from lowest (smallest) to highest, an RMS power value is calculated by 

dividing the sum square signal value by the sample count for that threshold.  Note that the power so 
calculated may not differ substantially from the RMS power of the entire signal for the lowest threshold 
(because the activity count, there may be substantially the same as the sample count unless there are 
long periods of silence). The computed power value becomes greater and greater for higher thresholds, 
due to the activity counts being lower. 



Detailed Description of Monitor Menu Functions 

GL Communications Inc. 69 August 2014 

Document Number: T1E1-8.7.28-03 

The first threshold for which the power value so calculated exceeds the power level associated with the 
threshold itself by the ‘margin’ -- specified by ITU-T P.51 as 15.9 dB -- is taken as the upper bound 
threshold for the purposes of computing the active voice level.  The next lower level is taken as the 
lower bound.  The actual active voice level is then computed by interpolation of the levels at the upper 

and lower thresholds.  The gory details are omitted here, but the idea is to do a binary search of the 
space between the lower and upper thresholds until the difference between the intermediate active 
voice level and intermediate threshold is within a specified tolerance of 15.9 dB.  The tolerance used in 
this implementation is 0.5 dB. 

The values of 200 ms for hangover time, 15.9 dB for the margin, and 0.5 dB for the tolerance were 
determined heuristically. Fifteen thresholds are used as suggested by the common use of 16-bit signed 
data, for which there are 15 numeric bits and one sign bit.  

Once the Active Voice Level has been computed, an ‘Activity Factor’ can also be computed.  This is the 
percentage of time that the signal is judged active.  Because of the nature of the algorithm described in 

above, this is the same as the ratio of the average power level to the active voice level, expressed as a 
percentage. 

 

Figure 75: Active Voice Level Real-time Processing 

Real-time Processing 

The Line In Data panel provides controls, by which the user can control, real-time Active Voice Level 
measurements. 

The controls are: 

 Click Select to activate the Line in Data panel, which in turn deactivates the File data panel. 

 Select a T1 or E1 trunk from the Card dropdown List. 

 Timeslots Pane contains push-and-latch buttons for each timeslot. When the button is latched 
down, the timeslot is selected and will be processed next time when the Run is clicked. This panel 
also contains Select All to select all timeslots and Clear All to clear all timeslots. 

All of these buttons are disabled when a run is in progress to calculate the AVL 
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Offline Processing 

 

Figure 76: Active Voice Level – Offline Processing Panel 

The File Data panel provides controls by which you can control offline Active Voice Level 

measurements. 

The controls are: 

 Click Select is used to activate / deactivate the File Data control panel. 

 Select the file to be processed from the corresponding directory by clicking on Browse. 

 This Number of Channels Entry Box only active when channel-multiplexed data is indicated by 
the position of the ‘Multiplexed’ button.  Use this box to specify the number of channels whose 
data has been multiplexed in to the file specified in the ‘File Name’ entry box.  If the ‘Multiplexed’ 

button is not latched down, this box is inactive. 

 Select the format of the data in the file from Data Format dropdown list. The data formats 
available are: 8-bit A-Law Compressed 8-KHz, 8-bit Mu-Law Compressed 8-KHz, 16-bit Intel PCM 
–8 KHz, and 16-bit Intel PCM –16 KHz. 

 This Progress Bar indicates the progress during offline processing.  
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Results Display  

 

Figure 77: Active Voice Level Result Display 

Active Voice Level statistics involving power are always reported in dB or dBm. Waveform amplitude 
statistics are presented either as FS Sine and Square Waves, as a percentage of the Full-Scale value, 

or in equivalent mill volts, depending on the Amplitude Units selection.  Equivalent mill volts are only 
available for A-Law or -Law data. 

The fields available in the Results Display section are: 

Ts: 

If Line In data is being used in real time, the data arrives on T1 or E1 timeslots. If File data is being 
used, Timeslot 0 receives statistics computed for the first channel in the file; Timeslot 1 receives 

statistics from the second channel, and so on, up to the number of channels specified in the ‘Number of 
channels’ box. 

AVL: 

Active Voice Level, as defined in ITU-T P.56.  Units are dBm for A-Law/-Law data, and dB relative to 

full-scale for 16-bit PCM data (such as from .wav files). 

Act%: 

Activity Factor is the percentage of time that the signal is considered ‘active’. 

Noise: 

Represents the noise detected on the selected timeslots while calculating active voice level in real time 

or offline. 

Max: 

This represents maximum positive value in a given waveform. Units are linear, % Full-scale or 
equivalent mill volts.  Equivalent mill volts are only available for A-Law or -Law data. 
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Min: 

This represents maximum negative value in a given waveform. Units are linear, % Full-scale or 

equivalent mill volts.  Equivalent mill volts are only available for A-Law or -Law data. 

Amax: 

This represents absolute maximum value in a given waveform.  Units are linear, % Full-scale or 
equivalent mill volts.  Equivalent mill volts are only available for A-Law or -Law data. 

DC: 

Represents DC Offset. Units are linear, % Full-scale or equivalent mill volts. Equivalent mill volts are 
only available for A-Law or -Law data. 

RMS: 

Represents the Root Mean Square value of signal present on selected timeslots and Amplitude Units 

In addition to the display itself, a number of other buttons may be used to control the display. Three 
buttons control the display of amplitude-based values.  Amplitude-based values include Max, Min, 
Max, and DC. These buttons control the display as follows: 

Linear Button (count): 

Amplitude-based values are displayed in linear form (that is, as ADC ‘counts’). 

% Full-Scale Button: 

Amplitude-based values are displayed as a percentage of the full-scale multitude value. For T1/μ-Law 
data, the full-scale value is 8192 counts.  For E1/A-Law data, the full-scale value is 4096 counts.  For 
16-bit data, the full-scale value is 32768 counts. 

Milli volts: 

Amplitude-based values are displayed in equivalent mill volts. Equivalent mill volts are calculated 
assuming 600Ω line impedance. This button is only active for T1/μ-Law and E1/A-Law data. 

There are other fields than can be seen in the Results Display simultaneously. You can view the 
additional fields by scrolling the display to bring those fields into view using the scroll bar at the bottom 
of the display.  

In addition, you can position the fields required by dragging the column headers and dropping at the 

required location.  You can also vary the width of the fields by dragging the divider between a field's 
column header and the one to its right. 

0 Db Reference:  

This indicates the zero point on the power measurement scale in decibels.  There are many ways that 

the zero point can be established.  ‘dBov’, for example, is one very commonly used 0 dB reference.  
The following terms clarify some aspects of the zero dB reference. 

FS (Full Scale) Sine Wave - In an A-Law based system, this would be a sine wave that swings 

between -4095 and +4095 counts.  In Mu-Law, the sine wave swings between -8192 and +8192 
counts.  In 16-bit PCM systems, the sine wave has minima and maxima at -32767 and +32767.  Zero 
dB is defined as the power of the sine wave that has minima and maxima at the extreme or ‘Full-Scale’ 
(FS) values. 

FS (Full Scale) Square Wave - This works exactly the same as a full-scale sine wave, except that a 
square wave is used instead.  The minima and maxima are +/-4095, +/- 8192, and +/-32767 for A-
Law, Mu-Law, and 16-bit PCM, respectively. 

Note that the power of a full-scale sine wave is about 3.01 dB lower than a full-scale square wave.  

Therefore, it makes a difference whether your power scale is based on a full-scale square wave or a 

full-scale sine wave. If your zero point is defined by a full-scale square wave, then a full-scale sine 
wave has a power level of -3.01 dB (ov) (Note: dBov == ‘dB relative to overload’).  If your zero point 
is defined by a full-scale sine wave, then the power level of a full-scale square wave is +3.01 dB(ov). 

Applications concerned with voice and/or music signals often (but not always) use a full-scale sine 

wave as the 0 dB reference because of the intrinsically sinusoidal nature of sound.  This can be a little 
confusing because computing the RMS power of a signal leads most naturally to a power value relative 
to a full-scale square wave.  Add 3.01 dB to convert the value to a scale whose zero point is defined by 
a full-scale sine wave. The SSP library supports either choice of zero point.  The default is the full-scale 
sine wave. 
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DBm -dBm is a power measurement commonly used in telephony.  A-Law and Mu-Law systems each 
have their own calculation, but both are loosely based on a full-scale square wave approximately 
defining the zero point.  Each calculation also has an additional term intended to offset the effects of 
companding. 

Two other buttons also affect the Results Display they are: 

Reset Button: 

Click Reset when you want to restart the Active Voice Level calculation. Note that the Active Voice 
Level calculation is a continuous display process that will continue indefinitely until the process is 
stopped or until the accumulated values are discarded and the data tracking structures are reset to 
initial values. Click this button to restart the calculation.  The data Structures are always reinitialized 
when a new run is started. 

Save Button: 

Click Save to save the contents of the results display to a file. Save this file in an appropriate folder in 

the Windows® file system and specify the name for the file. The data is stored in ASCII text form. 

Run Button and Run LED 

Once you have specified all the parameters for an Active Voice Level measurement, click Run to start 

the analysis. If you are analyzing T1/E1 data in real time (Line In Data), the incoming data will be 

processed indefinitely until you release the Run button. For offline processing (File Data), the process 
terminates automatically when the end of the file is reached. 

In either case, when a run is in progress, most other controls are deactivated and the Run LED next to 
the Run button flashes green. 

The Run button is deactivated if you have not specified the required information for a run. 

Logging Button 

 

Figure 78: Active Voice Level Logging Button Option  

 Click Logging to open the Logging dialog box as shown in the figure below. 

 Selecting the Enable check box allows you to log the analysis to a specified file. Clicking the File 

button allows you to browse through the directories and choose a filename. The files saved will be 
a text file and helps you to analyze the data later. 

 Select Log every check box to log the data analyzed to a file specified. For the selected time 

duration, the data will be logged. Un checking this option will put data only once at the end of the 
Run. 

 Enable the Statistics are cumulative radio button to get cumulative result.  

 Enable the Statistics are independent for each interval radio button to get the independent 

results of AVL. 

 Select Clear log at beginning of each run check box, which will clear the log file and starts 

logging afresh with every RUN. 
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Section 7.0 Description of Intrusive Test Menu Functions 

7.1 Basic Bit Error Rate Test 

The Bit Error Rate Test (BERT) application generates/detects unframed, framed, and fractional data 

that are defined in Pseudo Random Bit Sequence (PRBS). In addition to these, drop and insert 
capability is provided. A variety of standard data patterns are available for test purposes including 
static patterns. 

To open BER application, navigate to T1/E1 Analyzer > Intrusive Test > Bit Error Rate Test and 
select the card on which BER test has to be performed. The screenshot given below displays the BER 

Test application running on Card1: 

 

Figure 79: BER Test for E1 

 

Figure 80: BER Test for T1 
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The functionality of the PRBS data stream is illustrated in the figure below: 

 

Figure 81: T1/E1 PRBS Functionality 

 

7.1.1 Framing Patterns selection for T1/E1 

The framing patterns available in BER test are Unframed, Full Framed, Fractional without Drop and 

Insert (D&I) and Fractional with Drop and Insert modes. These can be selected from the drop-down 
menu in the ‘Full-Fractional-Unframe’ section. 

Unframed T1/E1: 

Entire T1/E1 bit rate is used to transmit /receive the selected pattern. In T1, the framing bit position is 

used for pattern data and not for framing bits. In E1, timeslot 0 is used for pattern data and not for 
framing bits. 

Full Framed T1/E1: 

The selected pattern is inserted such that all 24/31 timeslots are used. In T1, the framing bit position 
is used for the normal framing bits. In E1, timeslot 0 is used for normal framing bits. 

Fractional T1/E1 with Drop and Insert: 

The selected T1/E1 timeslots are dropped and the user-selected pattern is inserted into the selected 
T1/E1 timeslots. The selected timeslots must be contiguous and cannot wrap around the last timeslot. 
The unselected T1/E1 timeslots are passed through undisturbed. The Drop and Insert function 

preserves multiframe alignment in all framing formats. 

Fractional T1/E1 without Drop and Insert: 

The user selected T1/E1 timeslots are used to transmit/receive the selected pattern. The selected 

timeslots must be contiguous and cannot wrap around the timeslot 23/31. The data in the remaining 
channels is taken from the timeslots in memory. 

7.1.2 Pattern selection for T1/E1 

BER Test has various available data patterns as explained below 

Quasi-random signal source (QRSS): 

Quasi-random signal source (QRSS) is a modified version of the PRBS (Pseudo Random Bit Sequence) 
and 20 consecutive ones permitted. The length of this pattern is 1,048,575 bits. This pattern is 
generally used as a test signal to test T1 lines. 

2^6-1 (63): 

This is Pseudo Random Bit Sequence (PRBS) generated by six (6)-stage shift register. Here a 

maximum of five consecutive zeros and consecutive ones are generated. The length of this pattern is 
63 bits. 

2^9-1 (511): 

This is PRBS generated by nine (9)-stage shift register. Here a maximum of eight consecutive zeros 

and nine consecutive ones is generated. The length of this pattern is 511 bits. 
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2^11-1 (2047): 

This is PRBS generated by eleven (11)-stage shift register. Here a maximum of ten consecutive zeros 

and eleven consecutive ones is generated. The length of this pattern is 2047 bits. 

2^15-1: 

This is PRBS generated by fifteen (15)-stage shift register. Here a maximum of 14 consecutive zeros 

and 15 consecutive ones is generated. The Length of this pattern is 32,767 bits. 

2^20-1: 

This is PRBS generated by twenty (20)-stage shift register. Here a maximum of 19 consecutive zeros 

and 20 consecutive ones is generated. The length of this pattern is 1,048,575 bits.  See definition of 
QRSS. 

2^23-1: 

This is PRBS generated by twenty-three (23)-stage shift register. Here a maximum of 22 consecutive 
zeros and 23 consecutive ones is generated. The length of this pattern is 8,388,607 bits. 

CSU (Channel Service Unit) Loop Up Code: 

This code may be transmitted in unframed or framed mode, but should not be used in the fractional 
mode. The framed sequence consists of a repetitive 5 bit sequence ‘00001’ with the framing bit in its 

normal position. The unframed sequence consists of the same repetitive 5bit sequence without a 

framing bit. 

The CSU Loop Up Code operation is as follows: When Unit A transmits this code towards Unit B, it 
recognizes it and effects a loop on the entire signal back towards Unit A. Unit A upon detecting the 
returned signal declares Pat Sync, which is indicative of a signal loop in the system. Once this 
condition is established, the user of Unit A may perform BER testing and other tests on the looped 

signal. To unestablish the loop, Unit A must transmit the CSU Loop Down Code towards the remote 
end. 

CSU Loop Down Code: 

This code may be transmitted in unframed or framed mode, but should not be used in the fractional 

mode.  The CSU Loop Down Code is a 3 bit sequence  ‘001’ and is similar to the CSU Loop Up Code in 
the unframed and framed modes. 

The CSU Loop Down Code operation is as follows: 

When Unit A transmits this code towards Unit B it will unestablish a loop, if present. Unit A upon 

detecting the absence of the CSU Loop Down Code declares ‘No Sync’, which indicates that the loop is 
no longer in the system. 
Enabling the Network Loop-back Detection option in the Config dropdown menu sets the analyzer to 

detect the CSU Loop Up and CSU Loop Down Codes. If enabled, for about five seconds the Loop Up and 
Loop Down Codes are detected. The detection is performed for Framed CSU Loop Up/Down Codes and 
Unframed CSU Loop Up/Down Codes. The detection is also performed on Framed CSU Loop Up/Down 
Codes in which the framing bit overwrites an Unframed CSU Loop Up/Down Code’s LOOP_UP AND CSU 
LOOP_DOWN TEST 

 

(Use Two PCs for the test)  

Card1 settings  

D4 or ESF, No Loop back, Terminate, Int Clk  

Card2 settings  

D4 or ESF, No Loop back, Terminate, Int Clk  

 

Open the BER page by selecting the card_1 and select CSU Loop Up pattern with full 

frame format. Click the configuration Tab and select card_2.in the Rx tab, ‘Enable 

Network Loop back’ Detection. After few seconds the BER shows ‘Pat sync’.  

 

Change the BERT pattern to QRSS and observe the ‘Pat sync’. Close the BER 

application. Open the Transmit Tone application on card_1 and transmit the tone on 

either single or multiple timeslots. Open the spectral Display on card1 and observe 

the tone loop back from the card2. This shows that the Network is being established 

between the two cards. 

 

Open the BER application (on card1). Select CSU Loop Down pattern with full frame 

format. Transmitting this will establish ‘No sync’. Transmit any pattern (other than 

CSU Lookup) and observe the ‘No sync’ status remaining the same. To check whether the 

Loop is ‘UP’ or ‘DOWN’ user can transmit a tone on card1 and observe that the tone 

will not return back. 
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NIU Loop-UP and NIU Loop-Down: 

NIU loop Up/Down code is used, when the user wants to test from CO (Central office) out to a NIU 

(Network Interface Unit). Loop up code is of 5 bits ('11000' as defined in application) and Loop down 

code is of 3 bits (111). These are the repetitive sequences which are transmitted to establish and 
unestablish the loop for BERT testing. 

All Ones: 

It’s a Static pattern of continuous ones. 

All Zeros: 

It’s a Static pattern of continuous zeros. For T1 systems the line code should be set for B8ZS when 
using this pattern. 

1:1: 

It’s a Static pattern of alternating ones and zeros. 

1:7: 

It’s a Static pattern with one ‘1’ and seven ‘0’s. 

3 in 24: 

It’s a Static pattern with three ‘1’s in a string of 24 bits User Defined User definable 24-bit static 
pattern. 

7.1.3 Time-Slot Selection for Fractional T1/E1  

Start Timeslot: 

Enter the required start timeslot number. This channel number should be less than or equal to the last 
timeslot number. 

End Timeslot: 

Enter the last timeslot number. This timeslot number should be greater than or equal to the start 
timeslot number. The software automatically checks for the above two conditions. For drop and insert 

mode, the timeslots selected are dropped and the selected pattern is inserted into selected timeslots. 

 

7.1.4 BER Test Result Screen  

Frame Errors Statistics Column: Lists frame error statistics  

Bipolar Violations Statistics Column: Lists bipolar violation statistics. Indicates the number of violations 
of the AMI coding rule. 

Logic Errors Statistics Column: Lists all logic error statistics as explained in detail in the 

following paragraph: 

BER Test parameters 

Status/Errors: 

‘Pat Sync’ is displayed in this field if BER is less than 0.019. ‘No Pulses’ is displayed if no signal is 
received. 

Total Bit Errors: 

This is the Count of total number of bit errors detected after Pat Sync is achieved.  

Err Rate (Cont): 

This is the ratio of Total Bit Errors to the total number of bits received i.e., the BER. 

Err Second (ES): 

It is the number of seconds with one or more errors detected during the Pat Sync condition. 

Err Free Second (EFS): 

It is the number of seconds with no errors detected during the Pat Sync condition. 

%EFS: 

The ratio of EFS to Test Sec multiplied by 100, where, 

Test Sec = Test Run Sec – Loss of Pat Sync Sec. 

Severely Err Sec (SES): 

It is the number of Test Sec with a Bit Error Rate worse than 1*10-3 in each second. 



Description of Intrusive Test Menu Functions 

GL Communications Inc. 79 August 2014 

Document Number: T1E1-8.7.28-03 

%SES: 

This is the ratio of SES to Test Sec multiplied by 100. 

Degraded Minutes: 

The number minutes with a Bit Error Rate in each minute equal to or worse than 1.0*10-6 

%Dmin: 

This is the ratio of Degraded Minutes to the Test Run Minutes. Loss of Pat Sync time is included in Test 

Run Minutes. 

Loss of Sync Count: 

The count of number of times the pattern sync was lost. Pat Sync is automatically re-established if lost. 

Loss of Sync Sec: 

The total number of seconds the pattern sync was lost. If Pat Sync is momentarily lost and re-

established during 1 second interval (one or more times), then this count is incremented by one. 

Available Seconds: 

The number of seconds with a BER in each second better than .0*10-3 

%Available Sec: 

It is the ratio of available seconds to the Test Run Sec multiplied by 100. Loss of Pat Sync time is 
included in Test Run Sec. 

Unavailable Seconds: 

It is the number of seconds with a BER in each second worse than 1.0*10-3. The count begins at ten 
and after ten consecutive unavailable seconds has been detected. 

Insert Single Logic Error, Insert BPV: <Alt+E> Logic-This key is used to insert a single logic error. 
<Alt+B> BPV-This key is used to insert single shot BPV errors. 

<Alt+R> Restart-This key is used to reset all of the counters. 
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Application II -  Protocol Analysis  

Section 1.0 Protocol Analysis Overview 

1.1 Overview 

GL’s Protocol Analyzers can be used to diagnose signaling problems quickly and effectively by 
analyzing/emulating traffic on multi-protocol signaling networks. GL’s protocol analyzer monitors 

signaling interactions in fixed, access and wireless networks. It analyzes multiple protocols like HDLC, 
Frame relay, SS7, ISDN, TRAU, ATM, GSM, GPRS and more. It can make measurements on up to 
.31x16 = 496 timeslots for E1, or 24x16 = 384 timeslots for T1 from up to 16 E1 or T1 trunks. 

It also allows measurements on Ethernet based traffic. GL’s Protocol Analyzer can be easily configured 
to capture fractional E1 or T1 (DS0), sub-channels, hyper-channels etc. 

Intrusive and non intrusive protocol analysis, detail statistics, call trace, filtering and search, remote 
network monitoring and surveillance capabilities and many more features make the GL’s protocol 
analyzer the logical choice for maintenance, installation or engineering groups. 

GL's also provides Centralized Surveillance System complimenting the protocol analyzers using 

Open Distributed Architecture. The system is scalable, so that it can be used for various applications 
like Billing Verification, Fraud Detection, Protocol Analysis, Traffic Engineering, QoS, Call Recording etc. 
T1/E1 Probes are deployed in the field to monitor various protocols, which are collected at a central site 
into a database. Various client applications can be developed to interrogate database records. ISDN, 

SS7, GSM, GPRS, INAP etc. are all supported. The client can access database information remotely, 
including through Web Browsers. 

 

1.2 Invoking Protocol Analyzers 

The protocol analyzers and emulators are available as optional software with the GL’s tScan16™ T1/E1 

analyzer. Users require GL’s license integrating these applications with already existing T1/E1 Analyzer. 
Once the license has been installed properly, the application can be invoked from the main window of 
T1/E1 Analyzer, click Special Applications Protocol Analyzers to choose the licensed protocol 
analyzer application, or click Special Applications Protocol Emulators to choose the licensed 

protocol emulator application.  

The figure given below displays an ISDN Protocol Analyzer: 

 

Figure 82: Protocol Analyzer (ISDN) Interface 
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The protocol analyzer interface has normally five panes: the Summary View at the top, followed by 
the Detail View, Hex Dump View, Statistics View and the Call Detail Records View at the 
bottom. The Summary View columns can be resized and reordered using drag operation. 

The summary view displays information about frames like frame direction, frame type & more. The 

detailed view pane displays & decodes frame sync bits, control bits & data in detail. This information 
can be exported to an ASCII file for the further Off-line analysis and also printed. The export can 
include either all the captured frames or only the filtered frames defined by a comprehensive filter 
criterion raw frame data as hexadecimal and ASCII octet dump. 

The main menu and the tool bar are used to select an operation to perform. The status fields at the 
bottom of the window display miscellaneous analyzer status information. Most of the operations can be 
performed either using the main menu or the correspondent tool button.  

 

1.3 List of Available Protocol Analyzers and Emulators 

GL Communications Inc provides the following protocol analyzers, along with various playback 
applications: 

HDLC Analysis  HDLC Analysis, Playback, Impairment, Tx and Rx Utility 

(Refer to HDLC Analysis User’s Manual for complete 
details) 

ISDN Analysis and Emulation  ISDN Analysis (Refer to ISDNAnalyzer User’s Manual 
for complete details) 

SS7 (ISUP and MAP) Analysis 

and Emulation 
 SS7 Analysis (Refer to SS7 Analyzer User’s Manual for 

complete details) 

GSM Analysis and Emulation  GSM Analysis (Refer to GSM Analyzer User’s Manual for 

complete details) 

GPRS Analyzer  GPRS Analysis (Refer to GPRS Analyzer User’s Manual 

for complete details) 

UMTS Analyzer  UMTS Analysis (Refer to UMTS Analyzer User’s Manual 
for complete details) 

GR-303 Analyzer  GR-303 Analysis (Refer to GR303 Analyser User’s 

Manual for complete details) 

CAS Analysis and Simulator  CAS Analysis (Refer to CAS Analyzer User’s Manual for 

more details) 

V5.x Analyzer  V5.x Analysis (Refer to V5 Analyzer User’s Manual or 

complete details) 

Frame Relay Analysis  Frame Relay Analysis (Refer to Frame Relay Analyzer 

User’s Manual for complete details) 

ATM Analysis  ATM Analysis (Refer to ATMAnalyzer User’s Manual for 
complete details) 

MLPPP Analysis  MLPPP Analysis (Refer to MLPPP Analyzer User’s 
Manual for complete details) 

TRAU Analysis  TRAU Analyzer (Refer to TRAU Analysis User’s Manual 

for complete details) 

  

CDMA Analyzer  CDMA 2000 Analysis (A1), (A3, A7), (A9, A11) (Refer to 
CDMA 2000 Analyzer User’s Manual for complete 
details) 

Sa-Bits Analysis and Emulation  Sa-Bits Analysis (E1 Maintenance Data Link) (Refer to 
SaHDLC Analysis User’s Manual for complete details) 

FDL Analysis & Playback  FDL Analysis (Facility Data Link)- (Refer to section  FDL 
Analysis User’s Manual for complete details). 

SS1 Analysis and Emulation  SS1 Signaling Analysis (Refer to SS1 Signaling Analysis 

User’s Manual for complete details) 
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Section 2.0 Signaling Transitions (Optional Software - XX050) 

The Signaling Transitions application records all signaling bit changes along with the time-stamped 
indications for each bit. The time-stamp clock starts from zero and then continues by displaying the 
elapsed time-period for each bit in ‘ms’. The same application can also provide time-stamped 
indications of all extra bit changes for E1 systems in Data Display. The signaling transitions may be 
transmitted using Transmit Signaling Bits, Transmit Multiframe, Transmit Gaussian Noise, 
Transmit Tone, or Playback from File applications (available under Intrusive Test and Special 

Applications menu options). 

 

Figure 83: Signaling Transitions 

Some of the main features of signaling transitions application include ability to: 

 Capture signaling bit changes on either one or both the devices 

 Record on all or selected timeslots simultaneously 

 Record signaling transitions real-time and save the captured information to a file 

 Load the pre-recorded data from a file of type *.sig 

 

For complete details on Signaling Transition application, refer to Signaling Transition User’s Manual. 
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Section 3.0 Protocol Identifier and Classifier (Optional Software - XX089) 

3.1 Overview 

Protocol Identifier and Classifier is a classification tool that analyses the frames flowing through each 
link over the T1/E1 lines and classifies the protocol/traffic based on analysis. 

 

Figure 84: Protocol Classifier Application  

Once the frames on T1/E1 lines are identified by the Protocol Classifier, users can perform detail 
protocol analysis using protocol analyzers. This process can be automated with a tool, which can 
identify the traffic/protocol flowing on the T1/E1 lines and helps to invoke particular protocol analyzer 
for further analysis. 

3.2 Main Features 

 Capable of identifying and classifying traffic over T1/E1 based on HDLC, ATM, and TRAU protocols. 

 Classification of HDLC based protocols such as ISDN, SS7, PPP, Frame Relay, GSM, and so on. 

 Graphical representation displays the stream configuration of the classified protocols. 

 Statistical representation displays the device info, stream configuration, and protocol. 

 Stream Statistics view shows the total number of timeslots, sub-channels, and hyper-channels 

used by each protocol. 

 Provides an option to log the protocol detected along with the device and channel information into 
a user specified path. 

 Supports filtering to display the protocols of interest. 

 Supports custom configuration of the colors to easily distinguish protocols 

For complete working details of this application, refer to Protocol Identifier and Classifier User’s 
Manual. 
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Application III -  FDL Analysis (Optional Application –XX021) 

Section 1.0 Overview 

The FDL View and Save Data is an optional application that allows the users to view the raw hex 
bytes being received from the FDL bit stream, the Framing bit stream / CRC bit stream during real time 
analysis. This option is used to save the complete capture of all bytes received, into a file. 

The FDL Analyzer (FDLA) is an optional application that performs FDL decode and analysis on T1 
channels real time and off-line using saved files with High Level Data Link (HDLC) frames and bit-
patterned Extended Super Frame (ESF) data link messages. The FDLA requires T1/E1 analyzer to be 
set in ESF mode. 

The real-time mode of operation is used to capture stream of HDLC frames on the selected cards and 
also embedded bit-patterned ESF data link messages. Captured information can be saved to disk for 
later off-line analysis. 

Both real-time and off-line analysis presents the information in two layers: 

 Raw HDLC Frame data as a hexadecimal and ASCII octet dump 

 FDL message information 

HDLC frames are parsed according to Q.921; FDL messages are decoded based on the AT&T TR54016, 
ANSI T1.403, T1.408, I.431, G.963 and G.704. 

Multiple instances of FDLA can run simultaneously capturing data from several T1 lines. Each instance 
can capture the data up to four T1 lines. 

The frame information is displayed in two panes: summary view and detailed view. The detailed 
view pane displays the detailed information that includes all layers and can be exported to an ASCII file 

for the further off-line analysis. 

Captured Frames can later be used for traffic simulation using FDL transmit application.  

 

. 

For more details, refer to T1E1_FDLAnalysis_Playback User’s Manual and T1E1 Client Server 

VBClient User’s Manual. 
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Application IV -  Multi Channel BERT-MCBERT (Optional Software - 

XX018) 

Section 1.0 Overview 

Multi-channel Bit Error Rate Testing (MCBERT) measures the correctness of data received on T1/E1 
lines according to the repetitive pattern file.  

Refer to T1E1 MCBERT User’s Manual for further details on this application. 
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Application V -  Windows Client Server (Optional Software - XX600) 

Section 1.0 Client-Server Overview 

1.1 Overview 

Windows Client Server  

GL Server is an application that allows the user to control GL’s T1 or E1 test set via TCP/IP. GL Client 
is a Windows-based application that is distributed with GL Server as a sample client application. WCS 
runs under Microsoft Windows 95, 98, 2000, and NT. Refer to T1E1_ClientServer User’s Manual 

and T1E1 Client Server Command Reference for further details on this application 

WCS – TCL Client 

TCL (Tool Command Language) Client is a client application that allows you to connect remotely to GL's 
T1/E1 analyzer via TCP/IP and perform various functions such as Intrusive / Non-Intrusive T1/E1 
Testing, Monitoring Byte Values, Power level, Frequency, DC Offset, Transmit Tone, Digits, Signaling 
Bits, Error Insertion, Playback and record a data file. The TCL Client application includes a GLTclIfc.dll 
file, a packaged library that enables communication with the WCS Server from a TCL environment. 

Refer to T1E1 Client Server TCLClient User’s Manual for further details on this application. 

 

1.2 WCS Modules (Visit http://www.gl.com/client_server.html) 

WCS –Client Data Rx  

ClientDataRxT1/E1 is an optional WCS Server side module that provides the capability for "clients" to 
Rx T1/E1 data to Server. Previously one could only Rx files from the server location but not the Client 
location (in the case that the Server and Client are not the same PC).  Now the client can transmit ad 
receive files or T1/E1 data directly to the server. Its main functions are: 

 receives raw data from T1/E1 line and sends it to the client as task data messages  

 receives data from the client via task data messages and transmits this data on T1/E1 

 

 

 

Multi-Channel BER Testing (Optional Software – XX670) 

Multi-channel BER Testing server function allows the user to take advantage of the more advanced 
features of the HD boards. It supports transmit and receive of *.ber files, bit inversion on Rx pattern, 
and logic errors insertion for Tx and Rx patterns. Refer to T1E1 Client Server MCBERT Command 
Reference or visit http://www.gl.com/mcbertrxinwcs.html for more details. 

http://www.gl.com/client_server.html
http://www.gl.com/mcbertrxinwcs.html
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Section 2.0 Record Data to File  

 

Figure 85: Record Data to a File 

This application permits capture of data being transmitted on (any one) the T1/E1 cards to a file. The 
main features available with this optional software are: 

 Capture to a file from all or selectable contiguous timeslots (bytes may be captured in reverse 
order by clicking ‘Byte Reversal’ option).  

 Limited Capture (Specific number of bytes) to a file from all or selectable contiguous time slots 
by. Enabling the ‘Limited Capture’ allows specifying the number of bytes.  

When capturing 32 or 31 time slots, the format of the E1 signal will determine the content of the 

captured data in time slots 0 and 16. In both cases the time slot 0 will contain the frame 
synchronization pattern. In CAS mode, the first frame of a multiframe, time slot 16, will contain the 

multiframe sync pattern. In CCS mode the time slot 16 will contain user data. 

Example of Recording Data to a File 

Cross-connect ports of T1/E1 cards and record a file from a timeslot with tone present in it. Follow the 
steps below: 

1) Invoke the tone transmission application on card1. Transmit a tone into timeslot 1. Confirm that 
tone is being transmitted by listening on timeslot 1 of card2  

2) Invoke the Record Data to File application on card2. Select the start timeslot and end timeslot as 

1. Provide a file using the browse feature. 

3) Record for about 10 seconds. 

4) Use the Playback File feature play the just saved file to test that the tone was captured correctly 

and by verifying with an oscilloscope and speaker.   
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Section 3.0 Record from Multiple Cards 

 

Figure 86: Record from Multiple Cards 

This application permits capture of data being transmitted on (any one or all) T1/E1 cards to a file. 

Main features available for this optional software are: 

 Cards can be selected or deselected by clicking on the listed card number. 

 Capture of data from non-contiguous or contiguous timeslots is also allowed. 

 Bytes may be captured in reverse order or normal order. 

 Limited capture (specific number of bytes) to files from all or selected timeslots. 

 Selected cards or timeslots are denoted by highlighted bitmaps. 

When capturing 32 or 31 timeslots, the format of the E1 signal will determine the content of the 

captured data in timeslots 0 and 16.  In both cases, timeslot 0 will contain the frame synchronization 
pattern.  In CAS mode, in the first frame of a multiframe, timeslot 16 will contain the multiframe sync 

pattern.  In CCS mode the timeslot 16 will contain user data. 

Example of Recording Data to a File 

Cross-connect ports of T1/E1 cards and record a file from a timeslot with tone present in it. Follow the 
steps below: 

 Invoke the tone transmission application.  Transmit a tone into timeslot 1 and card1. Confirm that 

listening in on timeslot 1 on card on the speaker is transmitting the tone. 

 Invoke the ‘Record Multiple Data to Multiple Files’ module.  Deselect all timeslots. Select timeslot 
#1.  Provide a file name using the ‘Browse’ feature. Select device 2. 

 Record for about 10 seconds. 

 Use the playback file feature to play the just recorded file on card1 and verify that the tone was 
captured correctly with the help of a spectral display and speakers on card2. 

Save and Load Settings 

The settings during capture can also be saved and loaded for another instance using T1/E1 analyzer’s 
Save-Load Profile option. 
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Section 4.0 Automated Record/Playback (ARP) 

4.1 Overview  

The ‘Automated Record/Playback (ARP)’ application is an extremely versatile and rugged application 
incorporated in T1/E1 analyzer that makes it very easy for the user to run several transmit or receive 
operation tasks simultaneously. The basic tasks performed by this application are similar to the 
‘Playback File’ and ‘Record Data to File’ applications.  Each task runs in a separate thread similar to the 
functionality of the console-based Transmit/Receive File Utility (TRFU).  The status of each 
transmit/capture task is displayed in the Task Results Viewer. The Automated Record/Playback 

application further supports sub-channel and multiple sub-channel streams for transmission and 
reception. 

 

 

4.2 Invoking Automated Record /Playback 

Double click the T1/E1 Analyzer to execute the application. The T1/E1 Analyzer is located in the 

directory ‘\Program Files\GL Communications Inc. From the main window of T1/E1 Analyzer, click 
Special Applications Automated Record/Playback to open the application’s main screen as 

shown below: 

 

Figure 87: Automated Record/Playback 

 

4.3 Features of ARP 

The user interface of the application comprises of:  

1) Main Menu options: Provide various menus to transmit/receive data simultaneously. 

2) Task Status Viewer: Comprises of various columns to display the status of parameters for any 

given data file. 

3) Task Results Viewer: Comprises of various columns to display the status of all tasks queued in 

the Task Status Viewer. 

Following are the menu options available in main menu toolbar: 

 File Menu 

 Edit Menu 

 Process Menu 
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4.4 File Menu Features 

 

Figure 88: File Menu Options 

4.4.1 Open 

With the Open submenu option, the task data previously saved can be reloaded for viewing and/or 

execution. The selected file appears in the task status viewer along with other parameter information 
such as Card number, Timeslots selection, Invert bits selection etc. 

 

4.4.2 Save 

This option allows user to save all selected tasks to a file. The file can later be retrieved for Tx/Rx 
Operations with Open menu option. 

 

4.4.3 Load CTL Data 

This option allows the ARP to be compatible with the earlier console-based Transmit/Receive File Utility 

application.  The *.ctl files of Transmit/Receive File Utility can be opened in ARP for 
Transmission/Reception using the Load CTL Data.  The file thus opened can be viewed in the task 
viewer. 

Example of a CTL file: 

NOINIT SYNC // adf  

wait 500  

rx1 0-0 Rxout.ula 12800  

rx2 0-0 Sxout.ula 12800  

tx2 0-0 Rin.ula 12800 // Limited tx  

tx1 0-0 Sin.ula 12800 // Limited tx 
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4.5 Edit Menu Features 

 

Figure 89: Edit Menu Options 

 

4.5.1 Enter Data 

This option invokes the Tx/Rx Data Entry dialog window, where users can set the required 
parameters for any given task (Transmission/Reception) as shown in the figure below: 

 

Figure 90: Tx/Rx Data Entry window 

 

4.5.1.1 Tx/Rx Data Entry 

Filename: Click the ‘File Selection’ button to browse and choose the appropriate file from the desired 
location.  

Transmit/Receive: Select this option to choose ‘Transmit’ or ‘Receive’ action for the selected file. By 
default, Receive action is selected. 

Device Selection: Select the card numbers i.e. Card 1 and Card 2 for the Transmit and Receive 
operation.  

Timeslot Selection: Select the timeslot on which the required data has to be transmitted/captured. 
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Tx/Rx Parameters 

Limited Capture /Transmit: Check this option to limit the size of the data transmitted/ captured. 

The number of bytes to be set can be specified in the ‘Tx/Rx File Size’ text box. 

Continuous: Check this option for continuous transmission of the data. 

 

 Note: 

This option is applicable only for files being transmitted. 

 

Invert Bits: Each bit in every byte transmitted or captured is toggled from 1 to 0, or from 0 to 1.  

Reverse Bits: The bit order in every byte is reversed. This can be used for the purpose of secured 
transmission of data. 

Broadcast: The entire content of a file is transmitted through each timeslot selected. 

 

 Note: 

This option is applicable only for files being transmitted. 

 

Start Immediately: When this option is checked for any given task, the task gets executed 
immediately upon the reception of the open signal (ProcessOpen Task). However, when this option is 

not checked, the tasks listed in the task status viewer have to be started by manually invoking ‘Start’ 
signal (ProcessStart All Tasks). 

Safe Margin: (Default and User Defined) Allows user to set the number of bytes to be considered as a 
tolerance for Transmitting/Receiving Data. Set to ‘Default’ as a default option. 

Sub-Channels: This option is provided to allow the transmission/reception of data on specific bits 

(DS0 bits) on any timeslot(s). After checking the ‘Sub-Channel’ option, following options needs to be 

set: 

1) Sub-Channel Rate (DS0 bits): This specifies the rate at which data is Transmitted or captured. 

The available data rates are 8, 16, 24, 32, 40, 48, or 56 kbps. Each DS0 bit represents a sub-
channel of 8Kbps data rate. 

For example, to transmit data at 8Kbps, select any one available DS0 bit as a sub-channel. To 

transmit data at 32Kbps, choose 4 contiguous DS0 bits. 

Similar settings can be followed for receive operations.  

2) Sub-Channel selection: Selection of number of sub-channels in a timeslot sets the particular Hex 

value as a mask for Tx/Rx. This can be observed in the Sub-channels column in Task Status 
Viewer.  

Example of Transmission on Sub-channels: 

 In Tx/Rx Data Entry window, select a particular file, say ‘QRSS.BER’, for transmission on any card.  

 Select either one or more timeslots from the Timeslot selection. 

 Select sub-channel and data rate as 8 kbps.  

Depending on the selected DS0 bit (Sub-Channel), the Hex value in ‘Sub-channel’ column appears as 
shown below: 

 For 1st sub-channel -> 0x80 (MSB) 
       2nd sub-channel->0x40 
       3rd sub-channel->0x20  
       4th sub-channel->0x10 
       

       5th sub-channel ->0x08 
       6th sub-channel ->0x04 
       7th sub-channel ->0x02 
       8th sub-channel ->0x01(LSB) 
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Multiple Sub-Channel Streams: This option is provided to allow transmission/reception on multiple 
sub-channels. If the user selects only the sub-channel option, only one sub-channel of the rate 

selected is allowed to transmit. If the user selects multiple sub-channel option, data transmission in 
more than one sub-channel is possible with different streams. 

For example, if four sub-channels bits are set, it is possible to transmit four 8 kbps data streams or two 
16 kbps data streams. 

 

 Note: 

This option is applicable only for files being transmitted. 

 

 

4.5.2 Task Status Viewer 

The ‘Task Status Viewer’ window displays the following 16 columns, each column displaying information 

about the Tx/Rx parameters: 

Task: Lists unique task IDs for each tasks queued up in the Task Status Viewer. 

Filename: Displays file name used to transmit or capture the data. 

Transmit/Receive: Displays the action being performed i.e. Tx (for Transmission)/Rx (for Reception) 

Card#: Displays the card number i.e. Card-1/Card-2 selected for either Tx or Rx operation.  

Capture/Transmit size: Displays the number of bytes set for transmission or capture.  

Invert Bits: Displays ‘Yes/No’ depending on the selection made for the ‘Invert Bits’ option in the Tx/Rx 
Data Entry window. 

Reverse Bits: Displays ‘Yes/No’ depending on the selection made for the ‘Reverse Bits’ option in the 
Tx/Rx Data Entry window. 

Continuous: Displays ‘Yes/No’ depending on the selection made for the ‘Continuous’ option in the 
Tx/Rx Data Entry window. 

Safe Margin: Displays the number of bytes set as Safe Margin in Tx/Rx Data Entry. 

Timeslot Selection: Displays the timeslot or the range of timeslots that is utilized in the playback or 

capture. 

Broadcast: Displays ‘Yes/No’ depending on the selection made for the ‘Broadcast’ option in the Tx/Rx 
Data Entry window. 

Sub-channels: Displays ‘Yes/No’ depending on the selection made for the ‘Sub-Channels’ option in 
the Tx/Rx Data Entry window. Further it also displays the Sub-Channel Rate in Kbps and the bit(s) 
(sub-channel) that is (are) selected for a given timeslot in HEX value. 

Multiple Sub-Channel Streams: Displays ‘Yes/No’ depending on the selection made for the ‘Multiple 

Sub-channel Stream’ option in the Tx/Rx Data Entry window. 
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4.5.3 Task Results Viewer 

The status of each task can be monitored in the Task Results Viewer (TRV).  The main purpose for this 
window is to inform the user as to how each task is performing its assigned function.  There are seven 

different types of status messages that are posted as shown in the figure below: 

 

Figure 91: Task Result Viewer 

IN PROGRESS: Indicates that the task is currently running.  In this mode, the task results viewer also 

displays the number of bytes currently being transmitted or captured. 

SUSPENDED: Indicates the state where the task has been opened and is awaiting the ‘Start’ signal 
(ProcessStart All Tasks). 

COMPLETED: Indicates that the task has been successfully completed.  

TERMINATED: This status is indicated either when user manually terminates the running task, when 
none of the timeslots are selected, or when the selected file could not be read or written to. In such 

cases, task results viewer will display the number of bytes transmitted or captured before termination 
occurred.  

TERMINATED DISKFULL: Indicates that the task has been terminated by the application. The 
captured data can no longer be written, because of space requirements.  

 

4.5.4 Edit Task Data  

Edit Task Data allows the user to edit the data selected in the task status viewer by invoking the 
Tx/Rx Data Entry dialog corresponding to that task.  This dialog can be invoked by double-clicking on 
the selected row in the task viewer. 

 

4.5.5 Delete All Tasks 

This option helps users to delete all tasks listed in the task status viewer.  

 

4.5.6  Delete Task 

This option helps users to delete only the selected task in the task status viewer. 

 

 Note: 

Tasks can only be deleted from the Task Status Viewer only when no tasks are running. 
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4.6 Process Menu Features 

 

Figure 92: Process Menu Options 

 

4.7 Open Tasks  

This option initializes all the tasks listed in the task status viewer. The tasks that are configured with 
‘Start Immediately’ option will get executed immediately and the progress state of all the tasks will 
be displayed in the task results viewer. 

 

4.8 Start All Tasks 

This option sends out ‘Start’ signal for all the tasks listed in the tasks status viewer. All the tasks that 
have been initialized, but have been awaiting the ‘Start’ signal, will be executed. 

 

4.9 Synchronize Tasks 

When capture and transmit actions are started simultaneously, it is sometimes necessary to 
synchronize both the operations. Select this command before opening tasks to achieve synchronization.  

 

4.10 Terminate Tasks 

With this option, the selected task(s) will be terminated. 
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Section 5.0 Automated Continuous Capture (ACC) 

Automated Continuous Capture (ACC) provides the user with a new method of capturing data.  

Instead of capturing data from a card in one big block, it is possible to capture seamless chunks of data 
in files of the same size. 

 

Figure 93: Automated Continuous Capture 

 

5.1 Types of Captures 

ACC provides the user with two types of continuous capture options - capture based on size and 
capture based on time. In capture based on size, capture occurs for the mentioned capture size.  In 
capture based on time, each capture occurs for a period of time (based on minutes, hours, days, or 
months). 

 

5.1.1 Capture Based on Size 

When the capture is started, a filename prefix (chosen by the user), a sequence number (usually 0) 

and the extension are concatenated together to form the filename.  After the required # of bytes is 
written to the file, it is closed. The sequence number is incremented, and a new filename is created.  A 

sample layout is shown below 

<card#>_<filename prefix><sequence #><filename suffix> 

Assuming <card #> is 1, <filename prefix> is ‘temp’, <sequence #> starts at 0, and <filename 

suffix> is ‘.pcm’, and a default sequence length of three. 

1st Capture: card1_temp000.pcm 

2nd Capture: card1_temp001.pcm 

3rd Capture: card1_temp002.pcm 

Nth Captured file will be: card1_temp’n-1’.pcm 
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The sequence length can be set in the range 1 to 9 digits.  If no restrictions are set, the sequence # 
reaches ‘99..9’, then the sequence # is reset to zero and the previously captured files will be 
overwritten.  It is also possible to restrict the # of captured files to n, i.e., the sequence # would not 
be reset to zero, and the capture continues. 

Displayed below are the options: 

 

Figure 94: Periodic Trace Save Options 

 

5.1.2 Capture Based on Time 

It is possible to set the time period for each capture.  It is possible for each file to contain data for a 
minute’s size of data to possibly 24 hours size of data. 

Setting date/time filename mask allows the user to set the format of the captured file. 

%Y – Year 

%M – month (1-12), i.e., 1 – January, …, 12 – December 

%D – day of month 

%H – hour of day (0-23), 0 – 12 AM, …,23 – 11PM 

%I – minute 

Assuming the date is October 3, 2006, 5:48PM, the following date/time masks will generate: 

 ’%Y%M%D_%H%I’: ‘20061003_1748.pcm’. 

‘tmp_%M%D%Y_%I%H’: ‘tmp_10032006_4817.pcm’. 

In the field, ‘Limit Value’, the following entries indicate the duration of the capture for a single file: 

00:01   - 1 minute 

03:45   - 3 hours, 45 minutes 

23:07   - 23 hours, 7 minutes 
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5.2 File Recycling 

This is the process by which the user can control the captured files being written and reused.  The 
following options are given to the user: 

 Keep N Latest Files – Captures a maximum of n files, then resets the sequence # to 0, then 

continues to capture, as though it started from the beginning, over the same file. 

 Stop After N Files – Captures a maximum of n files, and no further captures occur. 

 Unrestricted – No restrictions at all 

For a clearer explanation, refer to the cases below.  In the following cases, it will be assumed that the 
# of sequence digits will be 3. 

 ‘Unrestricted’, the sequence # will reach a maximum of 999. After that, the sequence # resets to 
0, and recycles (or overwrites) the files that it first captured. 

 ‘Stop After N Files’, the sequence # will reach a maximum of N. N files were captured.  After that, 
all capturing will cease. 

 ‘Keep N Latest Files’, the sequence # will reach a maximum of N. The sequence # resets itself to 
0.  Capturing continues and will overwrite files captured earlier. 

 

5.3 File Storage 

The folder (‘Save Directory’) is where captured files are stored. 

Procedure for Automated Continuous Capture is as mentioned below: 

1) Invoke the ACC application from Special application menu as shown in the figure above. 

2) Select the timeslots and the devices on which the data has to be captured. 

3) To select saving options click on the Capture Options button, which displays the Periodic Trace 

Save Options screen.  

4)  Default directory path appears in the screen or the user might also select the desired save 

directory path.  

5) User can save the file based on sequential filename or date & time format. For sequential filename 

check option and enter filename as say ‘test.pcm’. 

6) If the user checks the option and doesn’t mention the filename, then the default filename would be 

the card & sequential number set, example ‘card 01_000.pcm’.  

7) For setting date/time filename mask allows the user to set the format of the captured file. Assuming 

the date is October 3, 2006, 5:48PM, the following date/time masks will generate: 
 ’%Y%M%D_%H%I’: ‘20061003_1748.pcm’. 

8) The sequence length can be set in the range 1 to 9 digits.  If no restrictions are set, the sequence # 

reaches ‘99..9’, then the sequence # is reset to zero.  

9) Before capture is started, a filename prefix (chosen by the user), a sequence number (usually 0) 

and the extension are concatenated together to form the filename. 

10) For capture based on size check the File Size Limit radio button and set the byte value say 1k 

bytes. 

11) For capture based on check the Time Limit radio button to set the time in HH:MM for continuous 

capture of data say 00:01, means for every 1 minute file is created. 

12) Set the Restrict or Recycle After N Files Options value to control the captured files being written 

and reused, say set the value to 5 and select any of the options - Unrestricted, Stop After N 
Files or Keep N Latest Files for restricting and recycling the captured files.  

13) Click on OK to apply the settings for data capture. 

14) Click on Start button in ACC screen to start the capture. 

15) The file capture details are displayed in the screen and the data is recorded in the file mentioned.  

 

5.4 Save and Load Settings 

The settings during capture can also be saved and loaded for another instance using T1/E1 analyzer’s 
Save-Load Profile option. 
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Application VI -  Capture & Transmit Dialing Digits/Tones (Optional 

Software - XX022) 

Section 1.0 Transmit Dialing Digits 

1.1 Overview 

The Transmit Dialing Digits application provides the ability to transmit DTMF, MF, MFR2-f, and MFR2-b 
digits. It also includes signal data from external files or from the GL board’s VF input. In addition to 
applying signaling bits control, it can perform other functions related to call establishment, progress, 
and termination. The applications’ interface includes options to set up/ place a call, and control tone 
frequencies, On-Hook and Off-Hook definitions, and other parameters related to the call. 

The options under Dial tab is used to set up and place a call, while the options under Set Up and 
Parameter tabs are used to set tone frequencies, On-Hook and Off-Hook definitions, and similar other 
parameters related to the call. 

 

Figure 95: Transmit Dialing Digits Test 
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1.2 Dial Tab 

On this tab, you build a Call Script by pressing various keypad and action buttons. Each entry in 
the call script is referred to as an event.  Because this is a transmit application, most events are 

transmit (Tx) events, but some receive (Rx) events crucial to call establishment are supported as 
well. Once the script has been created, it can be executed by pressing the Call button. 

Given below is a brief description of all the options available under Dial tab: 

 

Figure 96: Call Script Display 

 

Call Script Display 

It displays the list of the events that make up the calls. The list appears in the upper left quadrant of 
the Dial page. It is equipped with vertical and horizontal scroll bars that can be used to bring an event 
of interest into the display area. 

Call Script Save and Load  

The user can use the buttons at the base of the Call Script Display to save a script in a file, load a 
script from a file, or clear the call script. 

 

Figure 97: Call Script Save and Load 

Save (Export) – Use this button to save a script to a file in .txt format, which helps to view the 
transmissions carried out like digits, signaling, voice file etc. The application responds by presenting 

the Windows Save As dialog, in which the user specifies a file name and directory location for the file. 
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Load (Import) – Use this button to reload a previously saved script from a file. The application 
responds by presenting the Windows Open File dialog, in which the user can specify the file to load 
and its directory location. Note that the File Loads are cumulative. This means that the user can 
combine events from several saved scripts into a longer script.  If the user doesn’t desire to append a 

script from a file to the current script, the current script should be cleared before loading from file. 

 

Figure 98: Load Call Script 

Clear – Use this button to erase the current script and clear the Call Script Display area.  This action is 
irreversible.  If there is any possibility that the user may need a script in the future, the user should 
first save it to file before clearing it from the Call Script Display. 

Executing a script  

A script is executed by pressing the Call button.  Each event gets highlighted as the script execution 
continues.  At the conclusion of the script, the label on the call button is changed back to Call and a 
script completion message is displayed in the Status window.  The user can terminate the execution of 

call script at any time by pressing the Stop button. 

The message in the status window may display the following messages: 

Done! – Indicates that the script is executed to completion. 

Rx wait timed out! – Indicates that an awaited event was not received before the timeout timer 
expired. The event that timed out will be highlighted. 

Max Latency = n ms – Indicates that the script is executed to completion and the Display Measured 
Latency option was selected on the Set Up page. 

Tx Data loss -- Script terminated! – Indicates that an event could not be executed within the 
latency interval specified on the Set Up page.  The offending script event will be highlighted.  The user 
should either increase the latency and run the script again, or run the script in strict real-time mode. 

Close – Use this button to end the Transmit Dialing Digits application. The user should stop any 
running scripts before pressing this button. 
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Dial Digits Frame 

The controls in this frame are used to select a digit tone standard and the digits to be dialed when the 

script is executed. 

 

 

Figure 99: Dial Digits Frame 

The various controls are: 

DTMF/MF/MFR2-f/MFR2-b Digit Standard  

Select one of the four standards. The Digit Keypad changes according to the chosen digit standard. 

Digit Keypad 

The user can construct the sequence of digits to be dialed by pressing the keys on this keypad. The 
keys and tones generated in response to them depend on which standard has been selected.  The digit 
on-time, off-time, and aggregate tone power may be set in the data entry boxes that also appear in 
the Dial Digits frame. Component tone frequencies may be set on the appropriate Parameter tab. 

 

 Note: 

The tone parameters in effect when the digit event was created (i.e., when the keypad button was 

pressed) are recorded as part of the event.  It is possible to have different power levels, on- and off-
times, and component frequencies for different digits. 

 

Digit Time  

Set the Digit On-Time and Digit Off-Time by keying the desired values into these fields.  
Alternatively, the user may increase or decrease the existing values using the spinners at the right side 

of the respective data entry field.  On-time and off-time values are always in units of milliseconds. 

Digit Power  

Set the digit power either by entering the desired value into this field.  Alternatively, the user may 
increase or decrease the existing value using the spinner at the right side of the field. 

 

Tx Events Frame 

This frame contains buttons that allows the user to create various transmit actions such as transmit 
Off Hook, On Hook, and Wink signals; pause for a specified time; and route data from a file or from 
the GL Board’s VF input onto the selected transmit time slot. 

  

Figure 100: Tx Events Frame 
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The controls in this frame are: 

OFF-Hook, ON-Hook  

These buttons are used to specify that the Off Hook/ On Hook signaling bits pattern are being 

transmitted in the script. The Off-Hook and On-Hook definitions are initially those defined for the T1/E1 
Analyzer application as a whole, but may be explicitly modified using the options available under Set 
Up tab. Note that no time interval is associated with this event. 

 

 Note: 

Transparent signaling (no signaling bits control) is assumed at the outset of call script execution.  If On-
Hook/Off-Hook signaling is important in your application, the first event of your call script should set 

the On-Hook or Off-Hook condition. 

 

Sig Bits 

This button is used to set the signaling bits to any of the possible 16 (2^4) states. The defined 

signaling bits definition gets transmitted during a Tx event. Thus, this feature allows the customization 
of signaling bits definition apart from the conventional on-hook and off-hook signaling state definitions.  

The transmitted signaling bits can be observed by opening the Monitor Signaling Bits under Monitor 
menu on the appropriate port. 

Wink 

These buttons are used to specify that a Wink is transmitted in the script. A wink is an On-Hook-Off-

Hook- On-Hook transition of the signaling bits. Keying in the desired time in milliseconds can specify 
the duration of the wink. 

 

 Note: 

This event assumes that On-Hook signaling is in effect when the event starts. 

 

Pause 

This button is used to set the specified time period as pause period. The script will transmit idle code, 
with the current switch hook condition (if any) for the duration of the pause. The idle code is that 
specified in the configuration screen (refer to section Configuration Setup for T1/E1) for the GL board.  
Keying in the desired time in milliseconds can specify the duration of the pause. 

VF Input 

This button is used to specify that the GL board’s VF input is to be turned on at this point in the script. 
You specify the duration of the VF input by entering the desired time in milliseconds.  At the end of the 
specified time period, the VF input will be turned off. 

File 

This button is used to specify that the contents of a file be routed onto the selected transmit time slot 

for a specified period of time. The dialog responds by presenting the Windows Open File dialog, in 

which you specify the file to be transmitted and its directory location.  The file is assumed to contain A-
Law or Mu-Law encoded signal data. The user has to specify the duration of the transmission in 
milliseconds in the data entry field adjacent to the File…button. If the file is shorter than the specified 
duration, it is retransmitted from the beginning of the file. 
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Rx Events Frame 

This frame contains buttons that allow the user to create various receive actions. These actions 

generally cause the script to wait for various conditions such as On-hook or Off-Hook signaling bits or 
events such as Winks during script execution. 

 

Figure 101: Rx Events 

The controls in this frame are: 

Wait for On-Hook, Wait for Off-Hook 

Use this button to specify in the call script to wait for arrival of On-Hook or Off-Hook signaling bits 

pattern at the selected receive time slot before script execution continues. The Off-Hook and On-Hook 
definitions are initially those defined for the T1/E1 Analyzer application as a whole, but may be 
modified with the options under the Set Up tab. If the On-Hook or Off-Hook pattern is received, script 
execution continues with the next event. If it is not received before the timeout period expires, the 
script terminates with a timeout message. 

Wait for -> (signaling bits)  

This event feature is used to specify the script to wait for the defined signaling bits. The defined 
signaling bits can be any of the possible 16 (2^4) states. Apart from the conventional on-hook/off-

hook definitions, the desired signaling bits states can be defined at this field and the event waits for the 
reception of the defined signaling bits. When this event gets executed, the Tx event should send the 
exact signaling state defined for this field within the time out period specified.  

Wait for Wink 

This button is used to specify the script to wait for a Wink on the selected receive time slot before 
continuing.  A Wink is an On Hook-Off Hook-On Hook transition. If a wink is received, script execution 

continues with the next event.  If it is not received before the timeout period expires, the script 
terminates with a timeout message. Wink duration is specified on the Set Up page. 

Timeout (ms) 

This button is used to specify the timeout period for a wait.  A different timeout period may be 
specified for each wait event. 
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1.3 Set Up Tab 

Use this tab to establish general parameters for a given execution of a script.  Most of the parameters 
on this page are not associated with specific events but they apply to the script as a whole.  Thus the 

same script can be run on different time slots by changing the time slot on this page and then 
executing the script on the dial page. 

 

Figure 102: Setup Tab 

Given below is a brief description of all the options available under ‘Set Up’ tab: 

Time Slot  

Set the time slot to be used during script execution here.  The user may enter the time slot number 
into the data field.  Alternatively, the user may scan to the desired time slot using the spinner at the 
right side of the data entry field.  Note that time slot numbers are zero-based.  In addition, users can 
convert easily between channel number and time slot number with the following table: 

System Channels Timeslots 

T1 1 - 24 0 - 23 

E1 1 – 15 1 - 15 

16 – 30 17 - 31 

31  (CCS only) 16  (CCS only) 

Not used 0  (Not used) 

Figure 103: Time Slot 

Board 

Select the device to be used for the script execution. 

Rx Wink Duration (msec) 

The user can set the minimum and maximum duration of the OffHook phase of received Winks in this 
frame.  Units are always milliseconds. 

 

 Note: 

The Timeout for the Wait for Wink event specified on the Dial page must exceed the maximum Rx Wink Duration 
specified here or the Wait for Wink events may time out even though a valid wink is being received. 

 

OnHook, OffHook Signaling Bits 

Set the desired OnHook and OffHook signaling bits definitions here.  When the Transmit Dialing Digits 
application is started, the application-wide OnHook and OffHook definitions are copied into these fields. 
The user may change these fields to other values as appropriate. 
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Processing Options 

Latency - Many of the controls on this page revolve around the issue of latency. Latency is the worst-

case time delay between input and output.  All digital systems have inherent latency because it always 
takes at least one clock cycle to respond to an input. 

Under Windows, however, latency is even more of an issue because Windows is a timesharing system.  
It is able to give the appearance of performing many tasks simultaneously because it doles out 

processor time to the various competing tasks in short chunks (often called ‘time slices’).  The 
downside of this strategy is that a given task such as the one in which your script is being executed – 
may not have instant access to the processor, or may lose its time slice before it has completed its 
response to some input. 

The Transmit Dialing Digits application addresses this problem by delaying output of events by a fixed 

safe time margin within which it is guaranteed of getting sufficient processor time to complete its 
activities without losing continuity. This safe time margin is identified as latency on the Set Up dialog. 

Continuous Transmission  

Select this option to continuously execute the script. In this mode, the script restarts execution at the 
first event after the last event has finished executing.  The script must be stopped with the stop button 
when this option is selected.  If this option is not selected, the script executes exactly once and then 
stops. 

Display Measured Latency  

Select this option to have the application display the worst-case latency that it observed during 
execution of the script.  Often, it is beneficial to set a high latency value and select this option to get a 
feel for the actual latencies being encountered.  The user can then deselect this option and adjust the 

latency downward to a safe value, thus improving the responsiveness of the Transmit Dialing Digits 
application. 
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1.4 DTMF Parameters Tab 

The options in this tab allow the user to control the characteristics of DTMF digits that are generated 
during script execution. Characteristics that can be controlled are the frequencies of the tone 

components making up the digit and their relative power levels. 

 

Figure 104: DTMF Parameters.  

Given below is a brief description of all the options available under DTMF Parameters tab: 

High Group Frequency Sliders  

This provides a set of vertical slider controls that can be used to control the high-group tone 
frequencies either individually or all together.  Frequency deviations of up to 5% of the nominal 
frequency values can be specified.  Manipulate the sliders by clicking the left mouse button on the 
appropriate slider and dragging the slider to a new position.  Alternatively, the user may click on a 
slider and control its position using the cursor control keys on the computer’s keyboard. The new 
frequency value will be displayed in the associated frequency display box. 

Low Group Frequency Sliders  

This provides a set of horizontal slider controls that can be used to control the low-group tone 

frequencies either individually or whole together. Frequency deviations of up to 5% of the nominal 
frequency values can be specified.  Manipulate the sliders by clicking the left mouse button on the 
appropriate slider and dragging the slider to a new position.  Alternatively, the user may click on a 
slider and control its position using the cursor control keys on the computer’s keyboard.  The new 
frequency value will be displayed in the associated frequency display box.    

Power Twist (dB) 

Use this field to specify the power twist or relative power level between the low and high tone 
components. Negative twist values indicate that the power of the low-group tone is lower than the 
high-group tone by the specified amount.  Positive twist values indicate that the low-group tone 

contains more power than the high-group tone.  The user can specify twist by keying the desired value 
directly into the field. Alternatively, the user can increase or decrease the existing value using the 
spinner at the right side of the field. 

Defaults  

Use this button to reset all tone component frequencies and power twist values to their defaults. 

Cancel  

Use this button to cancel all the changes made to the settings.  Changes are made permanent 
whenever the Apply button is clicked or when a new tab is selected. 

Apply  

Click this button to accept any changes made to the settings. 
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1.5 MF Parameters Tab 

This tab allows the user to control the characteristics of MF digits that are generated during script 
execution.  Characteristics that can be controlled are the frequencies of the tone components making 

up the digit and their relative power levels.  

 

Figure 105: MF Parameters Tab 

Given below is a brief description of all the options available under MF Parameters tab: 

High Frequency Component Sliders: This provides a set of vertical slider controls that can be used 

to control the high tone component frequencies either individually or all together.  Frequency 
deviations of up to 5% of the nominal frequency values can be specified.  Manipulate the sliders by 
clicking the left mouse button on the appropriate slider and dragging the slider to a new position.  
Alternatively, the user may click on a slider and control its position using the cursor control keys on the 
computer’s keyboard.  The new frequency value will be displayed in the associated frequency display 
box. 

Low Frequency Component Sliders: This page provides a set of horizontal slider controls that can 
be used to control the low tone component frequencies either individually or all together.  Frequency 
deviations of up to 5% of the nominal frequency values can be specified.  Manipulate the sliders by 
clicking the left mouse button on the appropriate slider and dragging the slider to a new position.  
Alternatively, the user may click on a slider and control its position using the cursor control keys on the 

computer’s keyboard.  The new frequency value will be displayed in the associated frequency display 
box. 

Power Twist (db): This field is used to specify the power twist or relative power level between the 
low and high tone components.  Negative twist values indicate that the power of the low-group tone is 

lower than the high-group tone by the specified amount. Positive twist values indicate that the low-
group tone contains more power than the high-group tone.  The user can specify twist by keying the 
desired value directly into the field.  Alternatively, the user can increase or decrease the existing value 
using the spinner at the right side of the field. 

Defaults: Use this button to reset all tone component frequencies and power twist values to their 

defaults. 

Cancel: Use this button to cancel all the changes made to the settings. Changes are made permanent 
whenever the Apply button is pressed or when a new tab is selected. 

Apply: Click this button to accept any changes made to the settings. 
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1.6 MFR2-f Parameters Tab 

This tab allows the user to control the characteristics of MFR2 Forward digits that are generated during 
script execution.  Characteristics that can be controlled are the frequencies of the tone components 

making up the digit and their relative power levels.  

 

Figure 106: MFR2-f Parameters 

Given below is a brief description of all the options available under MFR2-f Parameters tab: 

High Frequency Component Sliders: This provides a set of vertical slider controls that can be used 
to control the high tone component frequencies either individually or all together.  Frequency 
deviations of up to 5% of the nominal frequency values can be specified.  Manipulate the sliders by 
clicking the left mouse button on the appropriate slider and dragging the slider to a new position.  
Alternatively, the user may click on a slider and control its position using the cursor control keys on the 
computer’s keyboard.  The new frequency value will be displayed in the associated frequency display 
box. 

Low Frequency Component Sliders: This page provides a set of horizontal slider controls that can 
be used to control the low tone component frequencies either individually or all together.  Frequency 
deviations of up to 5% of the nominal frequency values can be specified.  Manipulate the sliders by 
clicking the left mouse button on the appropriate slider and dragging the slider to a new position.  

Alternatively, the user may click on a slider and control its position using the cursor control keys on the 
computer’s keyboard.  The new frequency value will be displayed in the associated frequency display 
box. 

Power Twist (dB): Use this field to specify the power twist or relative power level between the low 
and high tone components.  Negative twist values indicate that the power of the low-group tone is 

lower than the high-group tone by the specified amount. Positive twist values indicate that the low-
group tone contains more power than the high-group tone.  The user can specify twist by keying the 
desired value directly into the field.  Alternatively, the user can increase or decrease the existing value 
using the spinner at the right side of the field. 

Defaults: Use this button to reset all tone component frequencies and power twist values to their 
defaults. 

Cancel: Use this button to cancel all the changes made to the settings.  Changes are made permanent 
whenever the Apply button is pressed or when a new tab is selected. 

Apply: Click this button to accept any changes made to the settings. 
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1.7 MFR2-b Parameters Tab 

This tab allows the user to control the characteristics of MFR2 Backward digits that are generated 
during script execution.  Characteristics that can be controlled are the frequencies of the tone 

components making up the digit and their relative power levels.  

 

Figure 107: MFR2-b Parameters 

Given below is a brief description of all the options available under MFR2-b Parameters tab: 

High Frequency Component Sliders: This provides a set of vertical slider controls that can be used 
to control the high tone component frequencies either individually or all together.  Frequency 
deviations of up to 5% of the nominal frequency values can be specified.  Manipulate the sliders by 
clicking the left mouse button on the appropriate slider and dragging the slider to a new position.  
Alternatively, the user may click on a slider and control its position using the cursor control keys on the 
computer’s keyboard.  The new frequency value will be displayed in the associated frequency display 
box. 

Low Frequency Component Sliders: This page provides a set of horizontal slider controls that can 
be used to control the low tone component frequencies either individually or all together.  Frequency 
deviations of up to 5% of the nominal frequency values can be specified.  Manipulate the sliders by 
clicking the left mouse button on the appropriate slider and dragging the slider to a new position.  

Alternatively, the user may click on a slider and control its position using the cursor control keys on the 
computer’s keyboard.  The new frequency value will be displayed in the associated frequency display 
box. 

Power Twist: Use this field to specify the power twist or relative power level between the low and 
high tone components.  Negative twist values indicate that the power of the low-group tone is lower 

than the high-group tone by the specified amount. Positive twist values indicate that the low-group 
tone contains more power than the high-group tone.  The user can specify twist by keying the desired 
value directly into the field.  Alternatively, the user can increase or decrease the existing value using 
the spinner at the right side of the field. 

Defaults: Use this button to reset all tone component frequencies and power twist values to their 
defaults. 

Cancel: Use this button to cancel all the changes made to the settings.  Changes are made permanent 
whenever the Apply button is pressed or when a new tab is selected. 

Apply: Click this button to accept any changes made to the settings. 
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1.8 Illustrating Use of Transmit Dialing Digits 

Refer to section Illustrating Capture and Transmit Dialed Digits Applications to know more about using 
capture dialed digits and transmit dialed digits. 

 

1.9 Sample scripts to transmit and receive calls 

Sample script to transmit a call 

Shown below is a sample script, which may be used to originate a call when the GL Analysis card is 
connected to a T1 wink start (R1) system. 

Tx OnHook 
Pause 2000 
Tx OffHook 
Rx Await Wink: min=10, max=1000: t/o=1000 
Tx DTMF-5: on=50, off=50, p=-10.0, p1=-13.0, f1=770, p2=-13.0, f2=1336 

Tx DTMF-1: on=50, off=50, p=-10.0, p1=-13.0, f1=697, p2=-13.0, f2=1209 
Tx DTMF-0: on=50, off=50, p=-10.0, p1=-13.0, f1=941, p2=-13.0, f2=1336 
Tx DTMF-0: on=50, off=50, p=-10.0, p1=-13.0, f1=941, p2=-13.0, f2=1336 

Tx DTMF-0: on=50, off=50, p=-10.0, p1=-13.0, f1=941, p2=-13.0, f2=1336 
Pause 1000 
Tx VFIn 45000 

Pause 1000 
Tx OnHook 

Sample script to receive a call 

Shown below is a sample script, which may be used to answer a call when the GL Analysis card is 
connected to a T1 wink start (R1) system. 

Tx OnHook 
Pause 2000 

Rx Await OffHook: t/o=100000 
Tx Wink 100 
Pause 1000 
Tx OffHook 
Pause 1000 

Tx VFIn 45000 
Pause 1000 

Rx Await OnHook: t/o=1000 
Tx OnHook 
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Section 2.0 Capture Dialed Digits & Tones 

2.1 Overview 

The Capture Dialed Digits application provides the capability to capture and display DTMF, MF (along 
with MFR2-forward and MFR2-backward) digits and User-Defined tones as they are received on one or 
several time slots. Multiple instances of the application may be invoked, each with different operating 
modes and options.   

 

2.2 Modes of operation 

This application provides two basic modes of operation: Manual and Scan for Off-hook Modes. In 
Manual mode, the capture operation simply stays on the selected time slot, displaying the digits 
received where as 'In scan for off hook mode', the scanning of successive time slots takes place and a 
detection of a on hook to off hook transition at a time slot would mark the beginning of the capture 

activity.  

Manual 

In this mode, the capture operation continues on the selected timeslot indefinitely until the Stop 
button is pressed or the user selects a new timeslot manually. The Start button is used to initiate 
capture on the selected time slot.  Additionally, in this mode, the signaling bit transitions are not used 
in determining whether or not to capture digits.  

 

Figure 108: Capture Dialed Digits (Manual Mode) 

Scan for Off-hook  

In this mode, the capture operation will scan successive time slots looking for a transition from on-
hook to off-hook.  Once it finds a timeslot that has gone Off-hook, the capture operation will stay on 
this timeslot until the timeslot goes back on-hook, or until the Time-out timer runs out, whichever 
action is performed earlier. Users can set the ‘Time-out’ period as shown in figure below.  
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Figure 109: Capture Dialed Digits (Scan for Off-Hook Mode) 

Regardless of off-hook/ continued digit activity status the application will resume scanning when Time-
out period expires. This scan operation will stop only on those timeslots which it detects going off-hook 

during the scan period. It will not stop on a time slot, which is already off-hook. 

Audible Tones: User can enable ‘Audiable tones’ in ‘Scan for Offhook’ mode to hear the dialed digits. 
This process may not be perfect, as offhook detection is somewhat slow and early digits may have 
passed before audio is set to the relevant channel. 
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2.3 User Interface 

This section describes the various interface options available in the Capture Dialed digits application. 

Start–This button is used to start Digit/Tones capture.  As soon as this button is clicked, its label 

changes to Stop and the green LED indicator flashes to indicate that capture is in progress. 

Stop– This button is used to stop Digit/Tones capture. As soon as this button is clicked, its label 
changes to Start and the green LED indicator stops flashing, indicating that digit capturing has 
stopped. 

Save– This button is used to save the captured data to log files for future reference.  

Clear– This button is used to clear the contents of the captured data window. Please note that the 
cleared data is not recoverable. 

The Digits Only option allows the application to detect and display all DTMF, MF, MFR2, user-specified 
tones, and other miscellaneous tones such as Dial, Ring and Busy Tones. The digits to be detected and 
displayed are selectable through the Options Button. Unrecognized digits and other energy burst 
such, as voice signals are not reported. 

 

 

Figure 110: Digits Only 

The Detailed Analysis option can be activated in conjunction with either Digits Only or All Activity 
options. In this mode the application will display detailed data including precise time measurement of 
each digit or burst, and component tone frequencies and power. 
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Figure 111: Digits –Detailed Analysis 

The Time-Stamp option can also be added when using the Detailed Analysis option. This will add an 

elapsed time clock reading to each burst received.  This clock starts from zero whenever start button 
is clicked, a new time slot is selected, or the display window is cleared using the clear button.  

In the image shown below, after 1.212 secs of starting the capture digits detection application, the 
analyzer captured MF-1 digit and then after 102 msecs (1.314 – 1.212) it captured MF 2 and so on. 

          

Figure 112: Digits –Detailed Analysis with TimeStamp 

The All Activity option allows the application to detect and display all digits and also displays 
unrecognized energy bursts as may occur with voice or out-of-spec signaling tones.  An ‘X’ is used to 
indicate unrecognized bursts when the Detailed Analysis option is not selected. 

 

Figure 113: All Activity –Detailed Analysis with TimeStamp 

 



Capture & Transmit Dialing Digits/Tones (Optional Software - XX022) 

GL Communications Inc. 129 August 2014 

Document Number: T1E1-8.7.28-03 

2.3.1 Options 

This button presents the Digit Capture Options dialog that allows the user to control the capture 
process and the way the information is displayed during capture operations. It provides five tabs, explained as 
below: 

 Use the Enable tab to select various encoding standards such as such as DTMF, MF, User-defined 
tones, Ring/Dial/busy tones, MFR2-forward, and MFR2-backward for detection. 

 Use the Parameters tab to set thresholds for power, duration, signal-to-noise ratio when 

detecting energy bursts and comparing tone composition to various standards. 

 Use the Signaling tab to change Off-Hook and On-Hook definitions. 

 Use the Logging tab to enable / disable logging of detected events to a file, to create, view, 

and/or erase log files. 

 Use the User-Defined tab to enter frequency component definitions of miscellaneous tones to be 

detected. 
 

 Note: 

The User-Defined tab is available only when User-Defined encoding standard is selected under Enable tab. 

 

Enable Tab 

This tab enables you to select various digits and tone standards for detection. You can select MF, 
DTMF, MFR2 Forward, MFR2 Backward, and other tones such as Dial Tone, Ring, and Busy including the 

user-defined tones. When User-Defined Tones is checked, a fifth tab is displayed, which provides 
options to configure the tone components. 

 

Figure 114: Enable Tab 

Detecting Tones: Generally digits are detected by computing the power spectrum of the received 

signal, determining the principal frequency components of that signal, and comparing these 
components to the definitions provided by the various standards.  The user can choose which 
standards to employ when you check the various options on the Enable tab. Signal segments having 
little or no energy are declared to be idle segments.   

Tone component matching is done as follows: 

If all tone components match to within 1.5% of the defined tone component frequencies, an 
unconditional match is declared.  The first such match found terminates the search for a match. 

If all tone components match to within 3.0% of the defined tone component frequencies, a 
provisional match is declared, but the search continues for an unconditional match. If no 
unconditional match is found, the provisional match is taken to be a match, but the digit will be flagged 
with a tilde (~). 

If the search terminates without a match, an unrecognized burst is declared.  

The various options on the Enable tab are: 
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MF Digits – Selecting this option the user can check MF Digits.  The digit labels and tone component 
frequencies used are: 

Frequencies 900 1100 1300 1500 1700 

700 1 2 4 7 ST3P 

900  3 5 8 STP 

1100   6 9 KP 

1300    0 ST2P 

1500     ST 

Figure 115: MF Digit Tone Frequencies 

DTMF Digits – Selecting this option the user can check DTMF Digits.  The digit labels and tone 
component frequencies used are: 

Frequencies 1209 1336 1477 1633 

697 1 2 3 A 

770 4 5 6 B 

852 7 8 9 C 

941 * 0 # D 

Figure 116: DTMF Digit Tone Frequencies 

Ring, Dial tone, Busy – Selecting this option the user can check for Ring, Dial Tone and Busy signals.  

The tone labels and tone component frequencies used are: 

Tone Label Low Frequency High Frequency 

Dial Tone 350 440 

Ring 440 480 

Busy 480 620 

Figure 117: Dial Tone, Ring, and Busy Tone Frequencies 

MFR2 Forward Digits – Selecting this option the user can check for MFR2 Forward Digits.  The digit 
labels and tone component frequencies used are: 

Frequencies 1500 1620 1740 1860 1980 

1380 1 2 4 7 ST3P 

1500  3 5 8 STP 

1620   6 9 KP 

1740    0 ST2P 

1860     ST 

Figure 118: MFR2 Forwards Tone Frequencies 
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MFR2 Backward Digits – Selecting this option the user can check for MFR2 Forward Digits.  The digit 
labels and tone component frequencies used are: 

Frequencies 1020 900 780 660 540 

1140 1 2 4 7 ST3P 

1020  3 5 8 STP 

900   6 9 KP 

780    0 ST2P 

660     ST 

Figure 119: MFR2 Backwards Tone Frequencies 

User-Defined Tones – Selecting this option the user can define mono- or dual-frequency tone signals.  
Selecting this option causes the User-Defined tab to appear, through which the user may enter tone 
definitions. Deselecting this option causes the User-Defined tab to be removed from the dialog. 

On-Hook/Off-Hook – Select this option to display On-Hook/Off-Hook transitions.  When this box is 

checked, the On-Hook and Off-Hook definitions appearing in the Signaling tab are used to detect 
transitions. 

 

Warning: 

Use caution when detecting on T1 time slots that may be carrying data (rather than voice). In this case 

the signaling bits may be uncontrolled resulting in a large number of meaningless detections. 

Parameters Tab 

 

Figure 120: Parameters Tab Option 

This tab allows the user to set the values of various detection parameters as explained below: 

Burst Power Threshold – This threshold represents the dividing line between burst and non-burst 
(‘inter-burst’) segments of the received signal. The signal is analyzed in 4 ms segments.  Any segment 
whose average power is above the threshold is classified as a burst segment. Consecutive burst 

segments are grouped together and further analyzed for frequency content. Segments whose power 
falls below the threshold are classified as inter-burst segments and are reported as idle. The default 
threshold is –27 dBm. 

Inter-Burst Length Threshold – This threshold is the minimum duration for an inter-burst so that 

the preceding and following bursts will be treated separately. This parameter is sometimes referred to 
as ‘hangover time’.  Its use avoids ‘split’ digits being declared as two successive digits.  It is also 
needed to prevent certain signals such as the North American ‘ring’ signal (which exhibits ‘beat’ 
frequencies) being declared as a long succession of very short rings.  The default is 20 ms. 
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Minimum S/N Ratio – This parameter allows the digit detector to distinguish between bona fide digits 
and noise or voice bursts which happen to have significant power in one of the DTMF/MF digit 
frequency ranges.  The signal power in the digit range is treated as ‘signal’, and the power outside the 
range is considered ‘noise’.  The signal to noise ratio must exceed the minimum S/N ratio for the burst 

to be declared a digit.  Otherwise, it is declared to be an unclassified burst. 

Absolute Twist Threshold - is the amount of difference between two power levels of digits being 
transmitted. 

Restore Defaults – This button helps to restore the default settings for all parameters of this screen. 

Signaling Tab 

This tab allows the user to establish the values of signaling bits parameters. These parameters are only 

meaningful if the Scan for Off-hook mode has been selected in the main application window, or if the 
user has checked the On-Hook/Off-Hook option on the Enable tab. 

 

Figure 121: Signaling Tab 

The Signaling Bits Definitions allow the user to specify the signaling bit patterns that will represent 
the On Hook and Off Hook conditions. These patterns default to the pattern specified for the T1/E1 
Analyzer as a whole.  

If you are using a multiframe (super-frames) format such as D4 or SLC-96 that uses only A and B 

signaling bits, all bits after the first two in each pattern are ignored. 

The other options are: 

Declare after n consecutive multi-frames – This value specifies the minimum number of 
consecutive multi-frames (super-frames) that must exhibit a defined signaling bit pattern (Off Hook or 
On Hook) in order for the switch hook condition to be declared. The default value is three consecutive 
multi-frames. 

Restore Defaults – This button restores the default settings for all parameters on this tab. 
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The user may change the values here by clicking the Change Definitions button to open the Setup 
for Tx Rx window as shown in the figure below: 

 

Figure 122: Setup for Tx Rx 

For detailed explanation on configuring parameters under Tx_Rx tab, refer to section Configuration Setup 
for T1/E1. 

 Note: 

The On-Hook / Off-Hook definitions made under the Tx_Rx tab using Capture DTMF/MF Digits 

application will be saved to the main configuration of T1/E1. 

 

Logging Tab 

This tab allows the user to enable or disable logging of detected events to disk file. In addition, it 

provides options to save the log file to the specific location, view the log file, and erase the log file in 
the specified location. 

 

Figure 123: Logging Tab. 

Enable Logging to File -- Check this option if the user wants to log detected events to a file. Note 
that the display window in the main dialog only holds from 32K to 64K of detection records. If the 
capture information greater than this has to be viewed for later purpose, the logging has to be enabled. 
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File Name - Enter the name of the log file you want to use in this box. The user can click the arrow at 
the right side of the box to display a list of recently used log files. The list is cleared between sessions. 
The user may either select an existing file for logging, or specify a new file by keying its name into the 
File name box. The Capture DTMF/MF Digits application recognizes two file name extensions: ‘.log’ and 

‘.txt’. If the user doesn’t specify an extension, ‘.log’ will be appended by default.  

View Log File - This button allows the user to view the log file using the Windows® Notepad. The user 
may also view the log file using other editors independent of this application. 

 

Figure 124: View Log File 

Erase Log File - This button clears the contents of the log file specified in File name text box. This 
button is only active if logging is enabled and a file name has been entered. 
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User-Defined Tab 

 

Figure 125: User-Defined Tab 

This tab allows the user to define signaling tones of interest that are not included in the MF, DTMF, or 
MFR2 standards. Either Mono/Dual-Tones may be defined. The user can specify a label by which the 
tone will be reported and up to two-tone components, which describe the frequency composition of the 

tone. This tab also allows the user to save your definitions to a file, and to reload those definitions at a 
later time. The options on this tab are: 

Label – This represents the name of the signal defined by the user.  

Lo Freq – This represents the low frequency component of the defined tone in Hertz.  Tone 
components must be listed from lowest to highest.  If this tone is a monotone, the tone frequency goes 
here. 

Hi Freq – This represents the high frequency component of the defined tone.  If this is a monotone, 
this field should be zero. 

Insert –This button allows the user to add new tone definitions to the list. It opens a Define Tone 
dialog in which the user may enter the label and frequency components of the new tone.  Any number 
of tones may be defined. 

Tone Definitions – Tone definitions are entered through the Define Tone dialog. The user can enter 
new tone definitions by pressing the Insert button or by double-clicking on an empty area of the 
defined tone list.  To modify an existing tone, double-click on the tone in the defined tone list. 

 

Figure 126: User-Defined Tones 

Remove – This button deletes an existing tone from the defined tones list.  The user should select the 
tone in the defined tones list before clicking the Remove button. 

Clear – This button removes all defined tones from the list.  This action is not reversible. If there is 
any possibility that the user may want to restore the tone definitions at some future time, the user 
should save them to a file. 

Load Defs (Load definitions) – This button is used to restore previously saved definitions from a file.  
The system responds by presenting the Windows File Open dialog.  By default, tone definition files 
have a ‘.rx’ file name extension. 

 Note: 

This action overwrites any definitions currently in the defined tone list. Tone definition lists may be 
combined using a text editor. 
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Save Defs (Save definitions) – This button is used to save the current list of defined tones to a file. 
The application responds by presenting the Windows Save As dialog, in which the user may specify a 
file name and directory location.  

In addition to the five tab controls in the Digit Capture Options dialog, the following controls are 

provided: 

OK - This button dismisses the Digit Capture Options dialog and passes all values set in the dialog to 

the Capture Dialed Digits application. 

Cancel - This button dismisses the Digit Capture Options dialog and abandons all values set in the 
dialog. Only the defaults settings are passed on to the Capture Dialed Digits application.  

Apply - This button causes all values set in the Digit Capture Options dialog to be passed to the 
Capture DTMF/MF Digits application. The ‘Apply’ button is only enabled when a change has been made 
to a field on the current tab. 

Help – Clicking this button invokes the help for the corresponding tab. This is an alias for ‘F1’. 

 

2.4 Illustrating Capture and Transmit Dialed Digits Applications 

 Invoke Transmit Dialed Digits on card1 and Capture Digits on card2 by following the procedures 

below: 

 Cross-connect Card1 and Card2 of T1/E1 card  

 In the Transmit Dialed Digits application, load a sample script ‘T1 R1 Wink Place Call 

terminate far end tx’ from ‘:\ Program Files\GL Communications Inc\USB T1 Analyzer\dtmf’ 
directory as shown in the figure below: 

 

 

Figure 127: Dialing Digits 

 Transmit digits by clicking Call button.  

 Capture the transmitted digits on Card2 using Captured Dialed Digits by clicking Start button 
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Application VII -  Call Capture and Analysis (Optional Software - XX030) 

Section 1.0 Call Capture and Analysis 

The Call Capture and Analysis (CCA) application is used to capture calls directly from the T1/E1 lines. 
Calls can be captured manually or captured automatically from both directions (east and west) of 
transmission using trigger action feature. Both manual and auto scanning capture can be performed on 

east and west directions simultaneously. In scanning mode all 24 or 30 channels are scanned for call 
initiation and recording. A separate signaling file for T1/E1’s is also provided.  

The call capture application supports following types of triggers for auto capturing of call –  

 Signaling based triggers - CAS -R1, wink start, MFC-R2 

 ISDN and SS7 message based triggers 

 Traffic activated triggers –  

 Voice based on a minimum power level 

 Tones of specified frequency - Ring back tone, Dial tone, Busy tone, and DTMF digits 

 Fax traffic - V.32 / V.17, V.27, V.29,   

 Modem traffic - V.22 forward/reverse channel, V.34 & V.90 uplink, Binary V.90 downlink, FSK 

 Any traffic based on any power level 

Subsequently, captured calls can be played back and analyzed in time and spectral modes using a 

commercial sound card, built-in high fidelity speakers, and audio viewing software (Cool Edit, Cool Edit 
Pro, and Adobe Audition). This software works in conjunction with the CMU (Call Management Utility), 
to automatically identify captured calls and calls being captured. You can also listen to calls that are in 
progress.  

Frequency, power of east and west directions cannot be shown in real-time in CCA application. We can 
only capture the files. The application indicates the channels on which a recording is taking place and 
the files names to which data is being stored. A message area provides status of the capture process. 

CCA includes the following applications: 

 Multiple Call Capture: This application allows the user to record calls directly from T1/E1 lines. It 

uses HD Universal T1 Cards (or E1 Cards), or GL's portable USB T1 (or E1) Analyzer to interface 
non-intrusively with T1 or E1 lines. 

 View PCM: There are several methods for viewing captured files supported by various third-party 

visualization programs such as Adobe Audition and Goldwave programs. Any of these graphical 
software programs should be installed in order to directly invoke mono (single file) or stereo (2 
files at a time one below the other) from the GL T1/E1’s Call Capture and Analysis (CCA) 
application. 

Refer to T1E1 Call Capture and Analysis Users’ Manual for further details on this application. 



Call Capture and Analysis (Optional Software - XX030) 

GL Communications Inc. 138 August 2014 

Document Number: T1E1-8.7.28-03 

(Intentional Blank Page) 
 



Call Capture and Analysis (Optional Software - XX030) 

GL Communications Inc. 139 August 2014 

Document Number: T1E1-8.7.28-03 

Section 2.0 Call Data Records 

This is an optional application (CDR032) that requires a dongle license. GL‘s Call Data Records module 

compiles the output of CCA and (optionally) VBA into Call Data Records reports. Two types of reports 
are generated: 

 The Call Summary Report:  This report contains a single summary line for each call, giving 

such information as the inbound and outbound ports, channel number, time of seizure and 
release, and other summary information. 

 The Call Detail Report: This report contains call summary data, as well as the progression of 
supervisory and in-band events during the call and an overall summary of in-band measures 
for each direction. 

Currently CDR supports ISDN, SS7, and CAS signaling types. Refer to T1E1 Call Data Records User’s 
Manual for further details on this application. 
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Section 3.0 Voice Band Analyzer 

This is an optional application (VBA032) that requires a dongle license. VBA is an analysis tool for 

monitoring voice band traffic over VoIP, TDM, and wireless networks. It can host an arbitrary number 
of analysis algorithms. VBA operates in near-real-time, processing the signal files recorded by CCA.  
VBA records its output into two files, the first containing overall channel measurements, and the 
second containing event records. 

Refer to Voice Band Analyzer User’s Manual for further details on this application. 
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Section 4.0 Multi Call Capture and Analysis (XX030) 

Multi CCA is an optional application which allows  users to control and run multiple capture instances 

on different T1/E1 ports from a single GUI  to monitor hundreds of calls. 

It can capture the bidirectional data, signaling, and traffic simultaneously from multiple T1/E1 lines, 
based on the user-defined trigger configurations.  

 

Refer to T1E1 Multi Call Capture and Analysis User’s Manual for further details on this application. 
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Application VIII -  Echo Test Solutions 

Section 1.0 Overview 

GL offers a wide range of G.168 echo canceller compliance testing and measurement software 
applications to handle everything from quick testing and verification to testing of very complex 
scenarios involving large networks. These applications can be used to simulate speech, add background 

noise, and measure delays through a variety of network configurations, including conventional 
telephone networks, networks with satellite connectivity, and wireless networks. 

 

The test suite for T1 and E1 Systems consists of the following listed applications –  

 

Measure Loopdelay/ERL Feature (Optional Application - XX063) 

The Measure Loop Delay/ERL application provides the capability to measure and display loop delay and 
echo return loss (ERL) on one or more time slots. Multiple instances of this application may be opened 
simultaneously, allowing measurements to be taken on multiple timeslot ranges and measurement 

strategies.  

 

Delay Attenuate Timeslots (Optional Application - XX062) 

This application allows you to apply delay, attenuation, and/or filtering to a received signal on any 
number of timeslots. 

 

Delay/Attenuate- Single Channel (Only for HD Cards and USB Portable T1/E1 Analyzers) 

(Optional Application - XX062) 

Delay/Attenuate Timeslots - Single Channel Application is an addition to the already existing Echo Test 
Solutions suite of applications. This application also facilitates Low Delay Echo Path Modeling. This 
application also allows you to apply; delay, attenuation (gain), and/or filtering to a received signal on a 
single timeslot. You may also mix-in additional signals from other sources, including speech signals 
inserted via VF input. Speech signals inserted via VF input and Gaussian noise signals or Tone 

generated internally within the application. 

 Note: Currently this application is not available on Octal/Quad T1 /E1 Analyzers. 

 

Digital Echo Canceller Simulator (Optional Application - XX066) 

Digital Echo Canceller is a G.168-2000 and G.165 compliant Echo Canceller. The DEC is licensed 
software that is shipped as a Windows DLL. 

GLC View waveform viewer  

GLC View is a waveform viewing application. It has been designed specifically as a companion 
application for the GL Communications Inc. T1/E1 Echo Canceller Test Suite. 

 

For complete details, refer to users’s guide T1E1 Echo Test Solutions User’s Manual. 
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Application IX -  Real-time Multi-Channel Audio Bridge (Optional 

Software - XX017) 

Section 1.0 Overview 

On popular demand, audio streaming between T1/E1 timeslots and a sound card is now available with 
the latest HD cards, USB and Universal Analyzers. The powerful feature of this audio driver is that the 
sound-card aware applications such as Goldwave, Matlab, and so on can send and receive data directly 
to/from a T1/E1 timeslot. 

Multi-Channel Audio Bridge monitoring application allows users to insert speech on T1/E1 lines 
using microphone and listen to the speech on T1/E1 lines using PC speakers or Headphone (requires 
internal or external sound card to be connected to the PC). 

For complete details on this application, refer to T1E1 Multi-channel Audio Bridge User’s Manual. 
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Application X -  Real-Time Strip Chart (Optional Software –XX024) 

Section 1.0 Overview 

The Strip-Chart Application is optional software available under GL Analyzer’s Special Application Menu. 
This is used to capture and analyze Signaling as well as PCM data captured at specified time slot 
using GL's field proven Ultra E1 or T1 internal cards or Laptop E1 or T1 external products.  

Refer to T1E1 Real-time Strip Chart User’s Manual for further details on this application. 
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Application XI -  Multiplex, De-Multiplex (Optional Software - XX040) 

Section 1.0 Overview 

This software provides the ability to multiplex files on different timeslots (up to 32 files) into one 
aggregate output file and to demultiplex one aggregate file into individual timeslots. The program is 

applicable to T1/E1 multiplex systems and is companion software for the files transmit and the files 
receive programs available with the T1/E1 cards.  

Refer to T1E1 Mux Demux User’s Manual for further details on this application. 
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Application XII -  Miscellaneous Applications 

Section 1.0 DCME Test and Analysis (Optional Software – DC007 & DC008) 

DCME testing, analysis and verification is easy with GL's DCME Analyzer. The DCME Analyzer is a PC-
based system using GL's Ultra E1 Card to connect non-intrusively to the bearer side of DCME 
equipment. Both real-time and post-processing of the bearer signal is possible.  

In real-time mode, the status of the bearer including synchronization, bearer loading, fax loading and 
other statistics are easily monitored.  

In post processing mode, the entire DCME bearer signal is captured to the PC's hard disk. The 
captured file is then post- analyzed. The software aligns to the DCME frame, and the DCME control 
channel(s) are decoded. The data can be displayed to permit bit level analysis and verification of 
channel mapping and implementation timing of the DCME protocol. DCMEs use variable bit rate 
encoding to create overload channels to handle overload conditions. Bearer channels are randomly 
selected for rate reduction. The software identifies the bit mode of each overload and normal channel 
(4, 3 or 2 bits). Facsimile Subframe analysis software permits bit level analysis and verification of fax 

data submultiplexing on the DCME output bearer signal. The DCME Analyzer software implements the 

mapping and interleaving algorithms, FEC and permits time of implementation verification. 

For more details, please refer to T1E1 DCME Analyzer User’s Manual. 
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Section 2.0 GL Insight™ (Optional Software – FXT001 & MDT001) 

2.1 Overview 

GLInsight™ is a state-of-the-art system that provides promptly processed information and analysis of 
data collected on IP and PSTN networks. Decoded results are analyzed on a per-network basis. 
Alternatively, data from two networks can be combined to provide additional insight into the 
networks’ behavior. 

GLInsight™ has a Windows®-based user-friendly GUI which supplies the developer with varied and 
valuable information. Results files and transmitted graphics, signal level, and signal quality are just a 
few of the diagnostic tools provided. 

GL Insight™ enables decoding and analysis of pre-recorded modem and fax transmissions. The 

transmission signals can be recorded from PSTN or IP media. It is a unique system used by 
developers of modem and fax technology often in interoperability labs. GL Insight™ can be used 
during the development and deployment phases of the products that support fax and modem 
transmission.  

GL Insight™ receives the recorded modem or fax transmissions in one of the two ways:  

 As raw signal files (PCM files) - in either mono or stereo format  

 As IP capture files - created by capturing devices or by software.  

GLInsight™ demodulates the raw transmissions and presents the decoded data in an easy to 
understand format. It produces extensive log files with all relevant debugging information for easy 
event tracing which in turn provides insight to potential sources of problems. 

 

Figure 128: GL Insight™ 

2.2 GL's tools for Fax and Modem Call Capture 

Over PSTN - The raw files required for fax and modem analysis in the case of PSTN (2-wire or TDM) 
can be obtained using following hardware platforms: 

 GL's T1/E1 Analyzer with Call Capture Analysis (CCA) - The capability of CCA software to non-
intrusively record calls directly from T1/E1 lines offers a solution to capture Voice/ Fax / Modem 
traffic from the 2-wire Analog interface. However, this capture solution requires the purchase of 
T1 / E1 Analyzer.  

 GL's 2-Wire Voice Recorder with Dual UTA - The Voice Recorder Software is primarily used in 

conjunction with Dual Universal Telephony Adapter (Dual UTA) hardware device to capture the 
voice/modem/fax data manually / automatically from the 2-wire Analog interface.  

 



Miscellaneous Applications 

GL Communications Inc. 156 August 2014 

Document Number: T1E1-8.7.28-03 

(Intentional Blank Page) 
 
 



Error! No text of specified style in document. 

GL Communications Inc. 157 August 2014 

Document Number: T1E1-8.7.28-03 

Section 3.0 NetSurveyorWeb™ (Optional Software – XX170 & XX171) 

GL's Centralized SS7 (and ISDN) Network Surveillance System uses an open three tier distributed 

architecture driven by non-intrusive hardware probes, intelligent software, and a database engine. 
The architecture consists of a scalable and flexible system, so the user can use it for multiple sites 
and various applications. T1/E1/T3 Probes are deployed in the field to monitor various protocols and 
conditions which are then collected at a central site into a database.  

Data records are stored into a centralized database (Oracle, SQL-Server, DB2, etc.) using ODBC. 
Various Client applications can be written (in VB, Power Builder, etc.) to interrogate database records 
and provide a user friendly interface for query and display. With the use of web server, the 
monitoring can also be facilitated using simple web browser interface, called NetSurveyor™. 

The NetSurveyorWeb™ is a user-friendly web-based client which accesses the results provided by 
the GL’s SS7 and ISDN signaling probes through a web server. As depicted in the screenshot below, 
one can view real-time and historic data including call ID, probe name/location, call disposition, 
called and called number, and call duration. Also available is the ability to filter the call records using 
a variety of filtering mechanisms including time/date, called/calling numbers, and SS7 OPC/DPC 
codes. 

For more details, please refer to NetSurveyorWeb™ User’s Manual. 
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